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IMPORTANT

The product described in this manual and products for use with it are subject to
continnous development and improvement,

This manual is provided to you free of charge and is intended only to assist the
reader in the use of the product and the information contained in this manual
and literature provided with the product is given by AMSTRAD in good faith.
AMSTRAD MAKES NO WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE AND AMSTRAD ACCEPTS NO LIARILITY FOR ANY LOSS OR
DAMAGE ARISING FROM THE USE OF ANY INFORMATION PROVIDED
OR OMITTED,

This manual may include technical Inaccuracies or typographical errors,
Changes are periodically made to the information contained herein; these
changes will be incorporated in new editions of the publication, AMSTRAD
may make improvements and/or changes in the product described in this
publication a1 any time but does not undertake to notify customers of these
changes.

The products referred to herein are not designed and should not be used for, or
in connection with, life critical functions or any sctivity in which an error or &
fault may result in physical damage or injury to person(s) and AMSTRAD does
not puthorise such use.

You must carefully read these instructions and all other literature provided with

the product

EXCLUSIONS OF CONSEQUENTIAL LOSS

IN ANY EVENT, AMSTRAD ACCEPTS NO LIABILITY FOR ANY CONSE-
QUENTIAL LOSE OR DAMAGE ARISING FROM THE USE OF THIS
MANUAL OR PRODUCTS USED WITH IT OR ANY INFORMATION
PROVIDED [N OR OMITTED FROM THIS MANUAL INCLUDING, BUT
NOT LIMITED TO, ECONOMIC OR FINANCIAL LOSS, DAMAGE TO
PERIPHERAL EQUIFMENT OR PRODUCTS, LOSS OF USE, PRODUCTIV-
ITY OR TIME.

Nothing in this document is intended 1o exclude or restrict any of the consum-
er's rights where 1o do so would be illegal.

Neither the whole nor any part of the information contained herein, nor the
preducts described in this manual may be adapied or reproduced in any material
form except with the prior written approval of AMSTRAD ple.
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Published by AMSTRAD plc

The PcW16 Software and Manual are copyright
© Amstrad plc and Creative Technology {MicroDesign) Ltd 1996

The Spelling portion of this product is based on Proximity Linguistic
Technology

THE PROXIMITY/AMSTRAD LINGUIBASE © Copyright 1995 Amstrad plc
© Copyright 1995 All Rights Reserved Proximity Technology, Inc

All correspondence relating to the PeW 16 product or to thils manuoal should be
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Amstrad Direct Led.

2 Marsh Road
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SETTING UP
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Setting Up Setting Up

Before you begin...

In order to set up your PeW 16 system, you will need a clear, dust-free arca
on & desk or table that is at least 41t wide and 31t deep.

When choosing a position for the system...
Make sure that all the equipment is installed close to, and within easy
access of, the electrical mains supply socket,
Make sure that the equipment is NOT situated near an artificial heat
source, such as a radistor, near a water supply, in direet sunlight, nor ina
humid or damp atmosphere, These elements can damage your system and
destroy data. Avoid a location where the system will be exposed to dust,
dirt, vibration, excessively high or low temperatures or rapid changes in
temperature. The operating temperature specification for this system is
between 10°C and 35°C. Do not put the system near other electrical or
magnetic equipment.

Legal Obligations for Employers
There are certaim minimum health and safety requirements which relate to
working with display screen equipment. These requirements are set by the
EC Directive (902 T0/EEC) and employers must comply with them.

General Health and Safety Advice

In order to ensure enjoyable and safe use of your system, it is important

that you give full consideration 1o ergonomics:

= Alwayssit comfortably al an appropriate height and distance for using
the equipment.

«  Position the screen to suit your needs and adjust the brighiness and
contrast controls to ambient conditions to avoid any discomfornt.

*  Place the kevboard in a comfortable working position to avoid fatigue
in the arms or hands.

*  Ensure there is adequate warking space.

*  Choose an adjustable desk or table so that you can position the screen
appropriately,

+  Ensure that there is satisfactory lighting; taking into account the type of
work and user’s vision requirements. Avoid disturbing glare or

Page B Amvitrad PCWI14 Amitrad PEW & Page #



Setting Up Setting Up

reflections. Ensure there is no distracting or disturbing noise or excess H
heat which could cause discomfort. SEttlng up ynur PcW16
= Activities should be planned so that daily work on a display screen is Step 1
periodically interrupted by breaks or changes of activity. As withall Unpack the boxes and check you have the following items:
electronic equipment, take regular breaks to-avoid evestrain and to rest PeW16 uni
: ; g ; ; . unit
your hands and arms. 1t is also wise 1o consider purchasing optional . Ke
filters and screens. 5 m}hnud
Important Safety Notes *  Thismanual
When the PeW 16 is switched on, do not obstruct the airflow sround it, “ itemeurisgs -
Venis are located on the unit, so the area around it must be kept clear; that *  Printer and Printer manual (optional)
is, do not place books, papers, or any other objects undemeath, immedi- The Rescue disk will be required during the initial setup process, but once
ately in front of, 1o the side of, or behind the unit. If the unit is obstructed, your PEW 16 is up and running, you will not need to use it unless something
the air low will be interrupted which will prevent the unit from being kept goes wrong. For further explanation about this disk, please read the
cool. Troubleshooting section in Appendix G of this manual.
WARNING:

DO NOT CONNECT YOUR PeW16 TO AN “IT" POWER SYSTEM
An “IT" power system is n power distribution system has no direct connec-
tion to earth. The exposed conductive parts of the electrical installation
miust be earthed.

Step 2: Keyboard and Mouse
Connect the Keyboard and the Mouse, as shown. The keyboard should be
placed in front of the screen unit. The mouse should be placed on the right
of the keyboard (or the left if yvou are left-handed), in an area where there is
space o move the mouse around. The surface should be clean (io prevent
clogging up the mouse mechanism with dust and dirt) and smoath (so you
can move the mouse easily). "You need an area of about 8" by 10™
(20 cm x 25 cm). A “mouse mat" provides a good surface, and helps keep
the mouse clean - these are availahle from most computer shops.

Page 10 Amstrad PCW 4 Amstrad PCWI8 Page 11
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Step 3: Printer (Y :
Connect up your Printer as shown. [fyou do not have a printer, ignore this
step - the PeW 16 will work without a printer attached.

Step 4: Switching On :
Connect the PeW 16 to the mains supply, and swiich on the power,

e
l o
o

=

First, the screen displays a message asking you to insert the Rescue Disc
into the disc drive. Insert the disc, then press the Green  key.

The system will spend a few minutes loading some essential information
from the disc, before displaying this opening screen:

1f you cannot see the screen clearly, adjust the contrast and brightness
controls as indicated on the diagram above.

The first time you use the PoW 16, leave it connected and switched on at the
mains for at least 2 hours. This will charge the internal NiCad batiery,
This battery is used to maintain the PeW16's internal date and time when
there is no external power (For example during a power cut, or if you
disconnect from the power supply).

Setting Up

PLEASE NOTE:
The rest of the steps in this section require that you type information into
your PeW 16, It does not matter if the information you type is incor-
rect: all the information can be re-entered correctly later on, and no prob-
Jems will result from incorrect information. 1 vou think you have made a
mistake, it does not matter: just carry on following the steps,

Step 5: Setting the Clock and Calendar
Now that your PeW 16 is up and running, the first thing you must do is sel
the Clock. To do this, you must enter the Time and the Date, by following
the imstructions on the screen,
Setting the Date
Notice how the instructions are displayed in boxes, which seem to appear
over the top of the main screen. These boxes are called "Dialogs", and you
will see a ot of them when using the PeW 16's programs. The first is used
to-set the Date.

Motice how the dialog itself tells you what to do. The line of white text on
a black background is an instruction, telling vou exactly how to enter the
information required.

When you type the date, vou should see it appear in the while box in the
middle of the dialog. As soon as you start typing, the existing dote is
cleared, and the number you type appears in its place. You must type the
date in the correct format - for example, if the date is the 2nd June 1996,
you should type "02/06/96", so that the screen looks like this:

... o
When you have wvped the date, you must press the Green o key 1o tell the
computer that vou have finished entering information in this dialog.

Page 11 Amstrad PCWI6
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Setting the Time
Afiter you have pressed the Green o key, the PeW 16 shows you another

dialog which asks you 1o enter the Time. Type the correct time, using a

colon to separate the hours from the minutes. For example, if the time is

9:30pm, you should type "21:30", 50 that the screen looks like this:
1.

Now, once you have entered the time, you could press the Green ¢ key to

tell the PeW 16 that you have finished with the dialog, but this time, instead

of pressing o key, try using the mouse.

Clicking with the Mouse - an Introduction

Instead of pressing ¢, you can use the mouse to finish off the dialog,

When you move the mouse across your table top, a little arrow painter

moves on the screen - move the mouse left or right, and the pointer moves

with it. You ¢an use the mouse pointer 1o point at objects on the screen,

then you can press the left mouse button to activate these ohjects,

If you have never used a mouse before, have a look at the following dia-

gram to see how to hold it

This shows how a right-handed person would hold the mouse, and press the
left button using their index finger. (Ifyou are lefi-handed, you can switch
the mouse buttons around. When you have worked through the Beginner's
chapter, look up "Lefi-Handed" in the index to this manual for instructions
on swapping mouse buttons, )

Now, to complete the Time dialog, try pointing with the mouse at this

"OK Button™;

$

This is called a button because you can " it - move the mouse until
the an-screen peinter is over the button, then press and release the left

Setting Up

button with your index finger, As you press the buttan, vou will see the
button become highlighted to show that you have clicked it.

This method, called "Point and Click”, is used by all mouse-operated
compulers. "Clicking On" something means pointing at it and pressing
then releasing the mouse left button, and many instructions in this manual
suggest that you elick on screen buttons and other objects.

Two Reassuring Notes

= Usinga mouse can be a litthe tricky ot first, but it becomes much easier
with practice.

+  Although it is often useful to be able 1o operate the computer using the
mouse, you do not have 1o use it You can always operate your PeW 16
using only the keyboard if you wish. In this case, instead of clicking on
the button;, you can simply press the Green o key, just like you did with
the first dialog.

Step 6: Entering Your Name and Address

Next, you have to enter your own details into the PeW 16, In order to
construct your personal headed stationery, the system needs to know your
name, address, and other details. 1t asks you to enter each line of your
name and address separately, in a series of dinlogs - after you type each
piece of infarmation, press the Green ' ey 1o enter it

Using Upper and Lower Case Letters - the Shift Key

When entering your name and address, bear in mind the following points:
Your letterhead will look best if you use upper and lower-case letters, like
this:

[ v t

To type a capital letter, hold down one of the Shift kevs while you
press the letter. The Shift keys have wide arrows printed on them.
Leaving Lines Blank and Entering your Post-Code
You can always leave a line blank by just pressing the Green ¢ key without
typing anything. You can enter up 1o five lines of address, plus an extra
line for your posteode - if your address only has three separate lines, just

Page 14
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press o 1o leave the fourth and fifih lines blank, then enter your postcode
when prompted to do so like this:

Step 7: Choosing a Printer
In order ta be able to Print from the word-processor and spreadsheet
programs, your PeW 16 must know which type of printer you have. 1fyou
have bought vour PcW 16 and printer together, you may have one of the
printers shown in the initial lisy;

If 50, select your printer by pressing the [+] key until the correct name is
highlighted, then press /.

Ifyour printer is not in the list initially displayed, press the 4] key three
times 1o reveal the list of “Other Printers”. Continue pressing [4] 1o select
your printer from the longer list, or to select the printer type which best
matches it, then press . For more information about different printers and
printer types, and how to work out the best match, see appendix C.

Onee you have chosen a printer, your PeW 16 will configure its "fonts®, or
typefaces, to suit the printer you have chosen. This process can take a
minute or two,

Step 8: Setting a Startup Option

This option i not essential to the PeW 1 6's operation - for the moment, just
press ¢ to sccept the default setting.

Page |6 Amstrad PCWIE
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The Desktop

The initial installation process is now finished, and you should see the
main PeW 16 startup sereen, which looks like this:

| lasks Srtup Qamas : H

ADDRESS BOOK

Click fere E

This screen is called the Deskrop, and it is the main screen from which you
choose which PeW 1 6 program you want to use. In future, when you
switch on your PeW 16, this is how the sereen will appear.

Switching your PcW16 On and Off - the Standhy Button
When you finish a session with your PcW 18, you should always switch off
uging the Standby button, This button glows red when the PeW 16 is in
Standby mode, and green when the computer is switched on. When you
switch off, it may flash for a short time, to indicate that it is saving any
unsaved wark, before tuming red. DO NOT SWITCH OFF THE
MAINS SUPPLY WHILE THE STANDBY BUTTON IS GLOWING
GREEN OR FLASHING - always wait for it to change to red before
switching off the power, or the automatic saving system may not work
properly.

Amstrad PCW 14 Page 17
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What to do next...

We suggest that you begin by reading the rest of general information given
in this chapter, then follow the step-by-step instructions in the Beginner's
chapter to get started.

How to Use this Manual

We strongly recommend that you keep this manual handy - il can save you
a great deal of time and trouble in the future!

The Beginner's chapter is a brief introduction to word-processing, and a
walk-through of some of the programs supplied with your PeW 16,

The Reference chapter contain a full explanation of every finetion and
program in your PeW 16 system. IF you run into trouble with a particular
program or command, look up the command name in the Index to find the
explanation of that command in the Reference chapter.

The Appendices contain extra information which may be of technical
interest, but which is not essentinl for general use,

The Glossary is a list of "jargon” terms, with an explanation of each term
in plain English.

The Mouse

The manual gives instructions for using both the mouse and the keyboard,
but is generally assumed that you will use the mouse where appropriate.
For some operations, specific key-by-key instructions are not given ifthe
operations can be done more easily with the mouse, 1fvou do not want to
use the mouse at all, you should read the tips on using the keyboard, which
are included in appendix D

References to Keys on the Keyboard

The manual uses “square brackets™ to refer to specific keys on the FeW 16
keyboard - for example, [G] means the G key, [S10p] means the STOP key
(atthe top lefi of the keyboard) and [Space] means the Space Bar. Some
keys have only symbols printed on them, but are referred to by name:

[Shift] the Shift kevs, which have {} symbaols printed on them;
[Space]  the Space Bar;

[Return]  the Return key, which hasa o symbaol printed on it;
[Tak] the Tab key, which has a ™ symbol printed on it

Setting Up

Key Combinations

Sometimes you have to press combinations of keys - for example when you
type a capital letter by holding down the [Shifi] key and press a letter. In
addition to [Shift], there are two other keys, [Tasks] and [Ctel] (or "con-
trol”), which operate in the same way as the [Shift] key - you hold them
down while pressing another key.

This manual indicates that you should hald down one key while pressing
another by using the "+" sign. This means that when the manual says
"Press [Tasks]+[Stop]®, it means “press and hold down the [Tasks] key, and
while holding it, press the [Stop] key™.

Floppy Discs

Your PeW 16 uses 3.57 1.44Mb "HD" type floppy discs:

You will not require these immediately because the PeW 16 has an intemnal
storage system called the Cabiner, However, you will need to make backup
copics of your work on foppy dise, so we recommend that you buy a box
of suitable floppy dises - these are available from most computer shops or
mail-order suppliers.

Help

There is a single line of "Help" information displayed across the bottom of
the screen at all times. You can also press the [HELP] key at any point to
see o more detailed Help information screen. The information displayed on
the help sereen is "context-sensitive” - this means that it changes as you use
different programs and commands, so that it always displays information
which is relevant ta whatever you are doing at the time.

The full help screens also include an "Index” button, which you can click to
get Help on a particular topic.

Amstrad PCWI8
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Setting Up Beginner's Guide

The Screen Saver
The screen of any computer can be permanently marked if one image is left
on it for a long time. To prevent this happening, the PeW 16 hns a "Screen
Saver"” system. Il you leave your PeW 16 for |0 minutes without touching
the keyboard or the mouse, the screen saved comes into operation - the
screen will clear and a moving “starfield” effect will be shown. As soon as
you touch the keyboard or mouse, the original sereen contents will be
restored, and you can continue working.

CHAPTER 2:
BEGINNER’S GUIDE
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1: The Desktop
This is the opening screen of your Pe'W 16, called the Deskiop.

Amstrad

WORD-PROCESSOR ADDRESS BDOK

(T ME“E

FILE MANAGER

The sereen shows the six différent programs which are supplied with your
PeW 16, These are

The Word-Processor

The Spreadsheet

The Address Book

The Diary / Alarm

The Calculator

The File Manager

You can choose any of these six programs by clicking on the relevant
button, (Remember that Clicking On something means pointing at it with
the mouse, then pressing and releasing the mouse left button.)
Alternatively, you can press the indicated key - F | for the Word-Processor,
F2 for the Spreadsheet etc. There are 8 F-keys aliogether: they are plum-
coloured, and are located in a row across the top of the keyboard.

You can return o the Desktop from any program by pressing the [Stop]
key - this the plum-coloured key located at the top left of the keyboard.

Page 11 Amstrad PCW I & Amstrad PCWI4 Paga 13
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2: The Word Processor

Mow it's time to ereate your first document. The purpose of this section is
1o show just the most basic use of the word processor, You will start the
word processor, give your new document a name, type in some fext, then
print the document. You will then go back to the same document, make a
few changes to it, then print it again,

Step 1: Starting and Naming a New Document

At the main Desktop screen, click on the WORD PROCESSOR button, or
press the [F1] key.

WORD-FROCESSOR

Clih Hars: E
wr Press

Mow elick on the NEW DOCUMENT button, or press the Blue key.

Type in a name for your document - you will see it appear in the box in the
middle of the dialog as you type. You can type up 1o 32 characters, includ-
ing spaces. (Mote that there are a few characters, such as the question-

Beginner's Guide

mark, which you are not allowed to use in document names. If you try to
type a disallowed character, the character will not appear.)

For this exercise, you are typing a letter to a Mrs Butcher, so type in
“Letter to Mrs Butcher™, (Always use a name that will be meaningful o
vou later), 1f you make a spelling mistake you can use the [+=Del] key to
delete what you have typed and start again.

When you have finished typing the name for your document, click the
dialog's OK button with the mouse, or press the Green o key.,

Choosing a Template

Mext, vou must choose the Template on which the new document is based.
A Template is a ready-made document style, and there are five different
templates supplied with your word-processor. As you are typing a letter,
you will need to select the Letter template: this template automatically
prints your name and address at the top of the first page, to save you
having to type it every time you write a new letter.

Click the mouse on the words "Letter template” in the list of templates, then
click on the OK button. (With the keyboard, press the T4 keys to highlight
the name "Letter template”, then press the Green ¢ key.)

Mote: whenever vou start a new document, you always have to select a
template. [fyou just need a plain document, select the “Blank™ template,

¥ ou can make your own templates, or vou can customise the supplied ones.

Page 24
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Step 2: The Word Processor Screen and the Cursor

Yaou should now see the word-processor's Document sereen, which already
contains your name and address at the top of the screen, and some other
standard text for letters - this text is already present because you selected
the Letter template.

When you type in a word-processor, the characters you type appear at the
Cursor, This is a flashing bar which you can move around the word-
processor screen using the Cursor keys - the Cursor keys are the group of
four keys with arrows printed on them:

«[[ ¢~

To begin with, the cursor uppnrs';taﬁ bcﬁirming of the document, just to
the left of your name at the top of the screen

Before you start typing the text of your letter, you need to move the Cursor
to the point where vou want this text to appear. You can move the cursor
using the cursor keys, or using the mouse. Try pressing [4] to movethe &
cursor down the screen,

With the mouse, move the pointer to the place where you want to start
typing, then click the left mouse button - you should see that the cursor
moves to the position of the mouse pointer.

Some General Notes on Typing

If vou have not used a word processor before you need to get used to the
feel of the keys, as well as learn what all the keys do. When typing, a light
touch is required, if you hold a key down for 1oo long it will be repeated on
the screen until you release it. 1f you find it more comfortable, angle the
keyboard using the flip-down legs. Tomake your typing look professional

Page 16 Amstrad PCW &
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the spacing should be correct; one space after a comma, colon or semi-
colon and two spaces after a full stop.

Typing Capital letters

To type a single capital letter, hold down one of the [Shift] keys then press
a character key. IF you want to type a whole word or more in capitals,
press [Caps Lock] once, then type the text. When you have finished press
[Caps Lock] again to switch the capitals off. While the Caps Lock is ON,
the Caps Lock indicator at the top right of the keyboard is lit.

Starting a New Line

When you run out of space at the end of & line, just carry on typing - the
word-processor will automatically move the next word onto the next line.
This is called “word wrapping™. For your word processor to distinguish
where one word finishes and another starts, you must Lype a space. Don't
forget to put » space-after a comma, and two spaces after a full stop.
Starting a New Paragraph

When you have finished a whole paragraph, press the [Return] key (the key
with the 4 symbol printed on it). This tells the word-processor that you
always want to start a new line at this point in the text,

Step 3: Typing the Text of your Letter

To begin typing vour letter, move the cursor to a position in between the
"Dear” and the following comma, about halfway down the screen on the
left. Remember that vou can move the cursor using the amow keys, or by
pointing and elicking with the mouse. Now type "Mrs Butcher”, so that the
beginning of the letter reads

Dear Mrs Butcher,

Mext, move the cursor down onto the next line by pressing [ ], then type
the text of vour letter. For the moment, it does not matter what you type,
but vou could experiment with word-wrapping by typing more than one
line. You could also try pressing [Retum] to stant a new paragraph.

Step 4: The Stop Key

When you have typed the letter, press the [STOP] key to tell the word-
processor that you have finished, The document will be stored automati-
cally under the name you gave it, and you can go back and edit or print it
al any Lime,

Amstrad PCWI4 Page 27
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Step 5: Printing
When you press stop, you retumn to the word-processor opening screen.
This time, you want to Print the letter vou have just typed, so choase Print
by elicking on the Print button, or by pressing the Green kev.

Now, the screen shows a dialog which lists the documents you have stored,
and allows you 1o choose one to Print.

/037
TE/D1/3E

Use the T4 keys 1o move the highlight over the “Letter 1o Mrs Butcher” (it
may be the only document in the list), or click on it with the mouse, then
press the Green  key or click on the "OK " button with the mouse.

Beginner's Guide

After a few moments, the document will appear on the sereen, then you will
see this dinlog:

Make sure that your printer is ready to print, then press  or click on the
"OK " button to begin printing.

If Your Document Does Mot Print...

~havea look at the Troubleshooting section in Appendix G. 1f the PeW 16
reports a particular message telling you why it can't print, this may give
vou aclue, Forexample, if your printer is switched off, you will probably
see a message saying "The Printer may be switched off™,

Step 6: Editing a Stored Document
Now that vou have created a new document and printed it, try Editing the
document (/e making some changes to it) and printing it again. To do this,
starting from the word-processar opening screen, click the Edit button, or
press the Yellow key,

This displays a list of the documents you have stored, just like the Print
button on the previous page. Choose the Letter to Mrs Butcher from the
list as before, then press o or click on the "OK ™ button.

You should now see the ward-processor screen showing your letter, When
Editing documents, there are two techniques which you will find especially
useful: Inserfing text, and using the Cut and Paste commands.

Page 18 Armstrad PCW &
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Beginner's Guide

Inserting text

To insert new text into an existing document, just position the cursor (using
the mouse or the cursor keys as explained earlier), and type the text. Any
existing text will move to the right or down the screen as you type, to make
raam for the new text,

Reformatting and Re-Paginating

Note that when you Insert text, the layout of the text on the screen may
appear to change in'a way which you did not intend. This rearrangement s
not permanent, and the text will be reformatted correctly when you stop
typing fora lew seconds, or if you press the Green o key.

11 you want to check the layout of the whale document, press [Ctrl]+[T] to
farce the word-processor to correct any anomalies in the document display
- this formaiting process is called "Re-Paginating”. The word-processor
does not re-paginate automatically, because repagination can take a few
seconds, and you cannot type while it is in progress.

Marking, Cutting and Pasting - the Scratchpad

If you want 1o move a section of text from ane part of the document to
another, you could delete and re-type it, but this would be very time-
consuming. The word-processor allows you to manipulate a section of
your document, by providing two "Markers", which you can place at the
Start and the End of your selected section of text.

If you place the Siart marker at the beginning of your selection, then place
the End marker at the end, the selected section is highlighted, so that it
looks like this:

This secthm ol text bv not selecied. This snctlon ks not velected.
Onee you hove selected i section of your document, you can remove the
selection and place it in a temporary storage area called the Scratchpad. In
this example, you will move a section of the 1ext from one place in the
document o anodher using the Scratchpad.

Placing the Markers with the Keyboard
In your example letter, moving the cursor to the beginning of a section you
want to move (it doesn’t matter which section you choose), then press
[Ctrd[+[M]. (Remember that this means "hold down the [Cirl] key and
press [M].} Now, move the cursor to the end of the section you want to

move, and press [Ctri+H{D]. The markers themselves are not shown on the
sereen, but you should see that the section of text berween them is now
highlighted.

Placing the Markers with the Mouse

Instead of using the keyboard, you can select a section of text by moving
the mouse pointer to the beginning of the section and pressing the middle
button, then moving the pointer 1o the end of the section and pressing the
right button. The section should then be highlighted.

Cutting Text to the Scratchpad

To remove the marked section and store it temporarily on the Scratchpad,
press [Ceel[+[X]. (To Cut with the mouse, you must choose the Cut
command from the Edit menu - see Menus and Commands at the end of
this section for more information. )

Pasling Text from the Scratchpad

To put the text you have Cut back into your document in a different place,
first move the cursor to the position where you want the text to appear.
Niext, press [Cirl][+{V] (or choose the Paste command from the Edit menu ).
The texi is inserted at the new position. .

Note that after you Paste, the text is not removed from the Seratchpad, so
you can Paste the same text again somewhere else if you want to, Old text
is only removed from the Scratchpad when you Cut (or Copy) a new piece
of text onto the Scratchpad, The Scratchpad can only hold one piece of
text at once,

Saving your Edited Document

Once you have made the changes you want to make to your document, vou
can press [Stop] (or click the "STOP" button with the mouse) to save the
new version. To print it, choose the Print button as described in step 5.

For More Information about the Word-Processor...

That concludes the Beginner's walk-through of the essential word-processor
functions, but the program is capable of n great deal more than we have
seen so far. For more information about the word-processor's capabilities
and how to use them, please see the Word-Processor section of the
Reference chapier,
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3: The Address Book

The Address Book allows you to enter and store names. addresses,
telephone numbers and other information, just like an ordinary address
book. From the Deskiop screen, to use the Address Book, click the Address
Boaok button, or press the [F3] key.

The Address Book screen looks like this:

Each entry in the book contains sixteen different "fields®, or categorics of
information. The names of these fields are shown down the left edge of the
Entry panel, on the left of the screen. In this example, vou will ereate a
new entry in the Address Book.
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Adding an Address Book Entry

Amstrad PCW I8

When you first use the Address Book, it is empty, g0 no entries are listed.
To create an entry, click the "Add Mew Entry” bution at the top of the
screen, or press the Blue key.

MNow type a Sumame. You will see the letters appearing in the "Name1"
section of the Entry panel as you type, We suggest that vou use the Namel
field for surnames, and the NameZ2 field for first names. 11 you make a
mistake you can use the [+Del] key to delete what you have typed.
Moving to the Next Field

When you have typed the sumame for vour new Eniry, press [Return] (the
key with the o symbol printed on it) to move to the next field, then type
the first name for your Entry. For example, if you were creating an entry
for "Fred Bloggs", you would enter the names like this:

You can type up to 63 characters into each field, though not all the charac-
ters may fit intoe the Entry panel display.

Conltinue typing the entry ficlds and pressing [Retumn] until you reach the
bottom of the Entry panel. IT you want to leave any of the fields blank,
simply press [Retumn] without typing anything.

When you press [Return] in the last field, called Notes, the Entry will
appear in the list on the Addresses panel.

Adding more Entries...

To add another eniry, click the Add button again, or press the Blue key.
Try adding a few more entries to your Address Book. Mote that while you
are typing a Mew Entry you are in “editing” mode. As soon az you change
from editing mode by clicking on another name in the list on the right, or
selecting a command from one of the menus, the Entry you are typing is
saved and appears in the list of Addresses.
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Editing an Address Book Entry

Once you have added two or three entries 1o the boak, you can try changing
(or "Editing") one of the entrics. To edit the Fred Bloggs entry, for exam-
ple, click on "Bloggs, Fred" in the Addresses panel, or use the T keys to

highlight it:

When an entry is highlighted in the list, its fields are displayed in the Entry
panel, with the text cursor in the "Name! " field. You can change the
Name| contents by typing extra letters, or deleting,

To edit the contents of one of the ficlds, click on the field vou want to
change, or press [Return] until the text cursor is flashing in the field you
want to change.

Leaving the Address Book Program

To save your Address Book and return to the main Desktop sereen, press
|Stop] or elick on the Stap button at the top left of the screen,

Beginner's Guide
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Using the Address Book Fields

You can use the different Address Book fields for whatever information you
want - just because a field is called "Tel 4% does not mean that you can only
use it for storing a telephone number. However, the standard way 1o use
the fields is as follows:

MNamel Surmame

MName2 First Name

Mamed Middle or Other Name

Title Mr, Ms, Mrs etc

Address] House naume, or number and street
Address2 MNumber and street, or Area

Address3 Town

Addressd County or State
Address5 Country or other
Post Code Postal or Zip code

Tell Home telephone

Tel2 Work Telephone

Teld Mohbile telephone

Teld Other telephone or Fax

Email Electronic Mail or Internet address

Motes Any extra information you want to add to the entry.

For More Information about the Address Book...

That concludes the Beginner's walk-through of the essential Address Book
functions. For full details of the Address Book commands, please see the
Address Book section of the Reference chapier.
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4: The Diary/Alarm Adding a New Appointment e
The Dinry/Alarm program allows you to keep o diary of appointments, and To make an new appointment in the Diary, click the Add button, or press
to sei "alarms" which display a message on the screen at the appointed the Blue key.
time. From the Desktop screen, you can choose the Diary program by To Add BLUE
clicking the Diary button, or pressing [F4]. ?nfi‘n’iﬁ".f P"E“DI

DIARY / ALARMI Mow you have to type the Message for vour appointment. Appointment

. messages can contain up to about 63 characters, though not all of these
chamcters may be visible on the screen at once, To store the appointment,
press the Green ¢ key.

. el = You should now see the appointment message (or the beginning of it)
The Difnyiiintar soibes ke s Ll displayed in the Appointments panel. Note that you have made this ap-

pointment for "today”, and that the black highlight for "today® in the
calendar is now shaded to show that it containg an appointment. The
illustration below shows how your sereen would look if you were doing this
exercise on July 31st 1996

asky Dats Yiew &py

B
16

FT

@234y

Iiud Jeily 17H

Turs Pags B

I"hc Appointments panel {n@l}mks mtl'n:r ike an ordinary diary. It can
show asingle day, or a whole week.

The Calendar panel (left) indicates which days have appointments, and is
used 1o set the day (or week) which is displayed in the Appointments panel.
The current day (as sct by the PeW 16's internal clock) is always shown in
black.

The Clock panel (bottom left) shows the current Time and Date,
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Editing an Appointment - Setting the Alarm Other Alarm Options
Now, with the appointment you just made highlighted, choose the Edit Mow press [Return] or click the "Mare 41" button, to see the other alarm
button; options. You can set your alarm (o repeat automatically every day, week,
- maonth or year, You can also choose whether you want the alarm operate -
“{i 5“, D il'you choose the alarm option, st the appaintment time, your PeW 16 will
ichere "" Fﬂl“ display a special dialog containing your appointment message, and can also
will again enter the intment message, but this Him m""df" audible "beep®. Note that this display of the appointment mes-
ximlfnﬁg:::ﬁﬁ::mmmmmw inthe déaiog. Wedanot sage will happen whatever program you are using at the time, and if the
want to change the message, but instead of pressing ., press the [Return] PeW16 is in Standby mode, Il“fll_l wake up” and display the alarm.
key, or click the "More I button. When you have set the Alarm option, the Diary screen shows the new
3 appointment;
Typing the Time

You will now see a dialog asking you to set the appointment time, Entera
time, making sure that you use the 24-hour formal. For example, 09:30am
can be typed as “9:307, “0930" or “9.30". Likewise, to set an alarm for
half-past six in the evening, you should type " 1 830" or "18:30",

When you have typed the appointment time, press [Return] or elick the
"More " button again.

Changing the Date

The next dialog gives you the option to change the appointment date:

B weree B

Note that the Appointments panel now shows the appointment Time, and
displays a little bell symbal to show that the appointment will display an

A stume At 08ec 16 move Dus spncinteent i “lomosmoi® - whiich s alarm at the appointed time.

h“ﬂﬂﬁl Ist. Youcould Ehﬂ]ﬂj" Iype “01/08/96", but instead, try I.l&i:I'I-E the Lga‘ri“g the th ‘f Alarm Frﬂsﬁm

"Spinner” buttons. To save your Diary Appointments and return to the main Desktop screen,
Using Spinner Buttons press [Stop] or click on the Stop button at the top left of the screen.

|;';| These are the little arrow buttons beside the date display. Youcan

[ “spin” the Date up or down by clicking these buttons, or by pressing
the T4 keys. Press the [T] key once or click the & button to move the

date forward by one day, 1o August 1st,
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5: The Calculator
Fram the main Desktop sereen, you can choose the Caloulator by clicking
the Caleulator button, or by pressing the [F5] key.

CALTILATOR

Cllak Harw
wr Fress

The caleulator works in a similar way to most simple pocket calculators.
You can use the mouse to click on the buttons on the screen, or use the
Calculator buttons on the keyboard. The Caleulator buttons are located at
the right end of the keyboard, and their special caleulator functions are
printed on them in light blue. (When the Caleulator is running, the normal
functions of these buttons are disabled.)

A Calculation Example

One particularly useful features of the Caleulator is the Percent [%6] button,

For example. you can add 17.5% (the standard rate of UK Value Added
Tax) to & number as follows:
* Type the number (eg 50 for 50 pounds)
= Press [+I
* Type the percentage to add (eg 17.5)
* Press [%]
The display now shows 59.75, which is 50 + 17.5%,
Leaving the Calculator

To leave the Caleulator and return to the Desktop, press the Green  key
{or [Stop]}, or click the Calculator's Exit button,

+ Exitto the
Desktop

Beginner's Guide

b: Introduction to Storage and Files

All the information used by your PeW 16, from word-processor documents
to typefaces, is stared in "Files®. Your PeW 16 can store files in two
different locations: internally in the "Cabinet®, or externally on a Floppy,
Disc. When you create a new document or spreadsheet, vou have to give il
aname - this is the name of the file, and you must also select whether to
stare the file in the Cabinet or on the floppy Dise.

Discs, the Cabinet, and Folders

The Cabinet

The Cabinet stores files using a type of memory chip (called a *Flash-
ROM") instead of a disc, so it has no moving parts. There is a total of
IMb {1024Kh) of Flash-ROM inside the PeW 16, but most of this memory
is used for storing the computer's operating system, programs, On-line
Help files, and typefaces.

The most important aspect of the Cabinet is that like o disc, it retains its
contents even when the PeW 16 is switched off and its power is discon-
nected,

Floppy Discs

The PcW 16 has a standard 3%4" disc drive, which can use either HD discs
(formatted a1 | 44Mb), or DD discs (formatted at 720Kb), HD discs are
recommended. You should use the floppy dise for creating extra copies of
your documents and files - these are called "Backup® copics, because they
can be used as a back-up if something goes wrong with the original file,
Note that the PeW 16 disc drive can be used to transfer word-processor
files from earlier PeW models such as the PeW9256 and PeW 10, See
Importing Docunens for more information.

A Technical Note about Dise Formais

The PeW I8 uses a dise forntat which is @ variant of the DOS formar
usedd by other types of persanal computer including the PC-compai-
ible and Macintosh fypes, 30 you can wse the floppye disc drive ta
sravyfer files between differemt machines and programs, See apper-
dix F for more information,
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Folders and Folder Mames

To help you organise your work, both locations contain sixteen different
“Folders" - when you create or copy a file, you can choose which folder to
put it in, and if you wish, you can give your folders suitable names accord-
ing to the type of information you store in them.

For example, as we have already seen, when you use the Start New Docu-
ment command in the word-processor, you will see this dialog:

As well as the box in which vou type the file name, there are two other
controls in this dialog, On the left are selector boxes for choosing the
Cabinet or the Dise, and on the right is a "drop-list" which allows you to
choose in which folder on the Cabinet or Dise your document will be

created.

u' hinet
Bl Dis

To see how these work, trying elicking on them with the mouse, 1fyou
want to access them using the keyboard, see appendix D for details.
Folder Mames

By default, the Cabinet and Disc folders are called "Folder01", "Folder02"
ete, but you can rename the folders in the Cabinet or on disc using the File
Manager program, For example, you might use the word-processor pro-
gram to write personal and business letters, You can keep these documents
separate by putting them in seperate folders, and you can make it easier to
find them by naming the folders *PERSONAL" and "BUSINESS".

Mote that Folder Names can have a maximum of only eight characters, and
cannot inglude any spaces, accented charncters, or punctuation characters.
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File Mames

When you ereate a document or other type of file on your PeW 16, you
must give it a nome. This name can be up to 32 characters long, and can
include spaces, accents, and any other character you can type on your
PcWitexcept *, 7.\, /, and |.
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7: The File Manager
Itis not necessary to use the File Manager in the normal course of using
the PeW 16, except for one important operation - backing up your work
from the Cabinet onto floppy dise. 1t is imponant to make backup copies
of your work, because there are many ways in which the original versions
can be lost or cormupted.
To start the File Manager program from the main Desktop, click the File
Manager button, or press [F&].

FILE MANAGER

ME.@

When you first run it, the File Manager shows a list of the files in Folder01
in the Cabinet. You can copy and manipulate these files individually or in
groups - see the File Manager section of the Reference chapter for more
information on how to do this.

For now, we will use the File Manager's Backup command to make a
complete copy of the Cabinet contents on a floppy dise.

Mote that to follow this example, vou must use o spare floppy disc. Any
existing information stored on the disc will be lost, so do not use a disc
which already contains impartant files, and above all, DO NOT USE THE
PeW16'S RESCUE DISC FOR THIS EXERCISE!

Backing up the Cabinet
Maost of the program commands we have used in this chapter have been
nccessed by clicking on-screen buttons, or pressing the coloured key.
However, only a small proportion of program commands are available on
buttons - most are accessible only through the Menu Bar. To use the
Backup command, you will have to select it from its drop-down menu,

Page 44

First, choose the Cabinet menu by clicking on the word Cahinet in the
menu bar, or by pressing [Tasks]+[C]:

Dachep Cabinat tu Din
lnmmn-h!;ﬁ.,.

This shows the "Cabinet” menu, which contains commanids for changing
some of the Cabinet settings. The command we want is the one for backing
up the Cabinel, so press [B] or click on the "Backup Cabinel to Disc”
entry in the menu.

When you select the command, the program displays this dialog:

Insert your spare Backup dise, and press /, or click the "OK ° button.
Allthe contents of the Cabinet, including the System Folder {see below)
will be copied onto the disc.

For more information about using menus and commands, see the next
section.

Advanced Note: The System Folder

Az well as the sixteen folders which you can use for storing vour docu-
ments and files, there is also an extra folder called the "System Folder®,
The System Folder is not normally visible on the File Manager screen
though you can choose to display il 1L is used 1o store special files used by
the PcW 1 &'s operating system and programs - these include the files which
contain the Address Book and Diary/Alarm information, the word-proces-
sor's typefaces and templates; the on-line Help for each program, and other
vital information. YOU SHOULD NEVER DELETE OR ALTER
ANY OF THE FILES IN THE SYSTEM FOLDER UNLESS YOU
KNOW EXACTLY WHAT YOU ARE DOING - see appendix F for
more technical information about the PeW 16' filing system.

Amstrad PCW 16
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g: Using Menus and Commands

Almost all the program commands which you have used so far in this
section have been selected by clicking buttons on the program screens.
However, there are many more commands avaifable in the program Menus,
which appear across the top of the sereen in the Menu Bar - if vou elick on
amenu name, a menu of "Commands” drops down from the name. To
choose a menu command, simply click on it with the mouse..

As an example, let's sce how to set the Desktop's Start-up option, which we
already dealt with in Step 8 of the Setting Up chapter. 1f you are currently
in cne of the programs, press [Stop] to exit and retirm to the main Desktop,
Choosing a Command from a Menu

The command for setting the startup option is in the Setup menw, which
appears in the Deskiop's Menu Bar across the top of the screen:

Amstrad

Click on Setup to see the menu of Setup commands:

The screen now shows the Startup Options dialog. We don't really want to
change the option, so click the Cancel button to cancel the command and

return to the Desktop.
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Using the Menu Bar with the Keyboard

Mote that all the menu names in the menu bar, and all the command names

in the menus, have one of their letters underlined. This is the Koy-Letter,

and you can use it (in conjunction with the [Tasks] key) to activate menus

and commands from the keyboard, without using the mouse.

Forexample, the menu-and-command sequence we have just done with the

mouse can be exccuted just as easily from the keyboard, by pressing the

following sequence of keys:

[Tasks]#[5] chooses the Setup menu, because the S in Setup is under-
lined. Onee the menu is visible..,

(5] chooses the "Set Startup Options" command, because the S
in "Set Startup Options” is underlined.

¥ (Red) Cancels the command. 1T the sereen is showing a dialog with
OK and Cancel buttons, vou can always choose Cancel by
pressing the Red X button,

So remember, press the [Tasks] key in conjunction with the initial (under-

lined) letter of the menu title to see the menu, then press the underlined

letter in the command name. Mote that while menu names always have

their first letter underlined, the underlined letter for a command is not

always its initial letter.

Hot-Keys

All commands are accessible by choosing the menu followed by the com-
miand, but many commands also have their own "hot-keys®, which allow
you lo select the command directly.

1f you have followed this Beginner's walk-through in full, you have already
used a hot-key to access a command. In the word-processor, you pressed
[Carl]+[M] and [Ctri]+[D] to mark the start and end of a section of text,
then [Ctrl][+[X] and [Ctrl}+{V] to Cut this section to the Scratchpad and
Paste it back info a different part of the document.

If you go back into the word-processor by pressing [F1] from the Desktop
{you will have to Edit an existing document or Start anew one before you
can start using the program), then elick on the Edit entry in the Menu Bar,
you will see that this menu includes the commands for Mark Start,

Mark End, Cut and Paste. All these commands have their hot-keys listed
beside them.
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9: Using Dialogs
¥ou have already had some practice at using "Dialogs™ - remember, these
are the boxes which appear in the middle of the screen, and which require
vou to enter information or set options. Almost all dialogs can be termi-
nated by pressing the Green o key to confirm the settings, or by pressing
the Red X button to cancel them. Usually, you can also press the [Help]

key for information on what the dialog settings mean. This section outlines

how to use Dialogs with the Mouse, which is recommended because the
mouse provides a simple point-and-click method of changing the dialog

settings. However, if you really do not wani to use the mouse, you can also
control dialogs using the keyvboard. For detailed instructions on this, pleass

refer to appendix D,
Dialag “Objects"

You have also had some practice at using some dialog "objects” - these are
the components in a dialog, which let you enter information and set options,

For example, you have already learned how 1o elick Buttons, which look
Tike this;

-..and operate Spinners, which look like this:

As you use more of the PcW 1 6's progmms and commands, vou will also
need 1o know how to operate three other important types of dialog object.
Lists and Scroll Bars

A List is simply vertical list of options, from which vou narmally need to
select only one - the current selection is highlighted, and you can use the

mouse (or the T4 kevs) to change the selection. For example, when going

through the Setting Lip process, you chose from the list of printers which
are compatible with your PeW 6. The full version of this list is:

Canon Bubiblejet 1B model

IBM XZ4E or compatible +/

Beginner's Guide
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FY In this example ofa List, there are more items in the 1ist than will fit
into the space available, so the list has a "Scroll Bar®. You can click
ol with the mouse on the scroll-bar arrows to see all the items in the list.
in As well as operating Lists, Scroll Bars are used in other functions and
ebjects in the PeW16 system,
Drop-Lists
A Drop-List is a special kind of list, where you normally see only the
current setting. The other settings you can select only appear (or
“Drop Down") when you elick on the drop-list.

select one of its options. It then reverts to its original appearance, with the
new setting visible.

Options Boxes

These are the easiest dialog objects 1o operate: simply click on the box to
select the option.

CEETETmTTT—— (EETETIITT—
This Option is Selected This Option is not Selected

Usually, you ean just click on Options boxes to select them, and click them
again to de-select the option. However, some sets of Options boxes are
mutunlly dependent - in other words, selecting one aption automatically de-
selects the other options. For example, when Starting a New Docment in
the word-processor, you can choose whether to create the new document in
the Cabinet or on disc. The document cannot be in both places at once, so
choosing the Cabinet option de-selects the Disc option, and choosing the
Dise option de-selects the Cabinet option. Groups of options which de-
select each other like this are sometimes called "Radio Buttons®,
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By contrast, in the word-processor's Text Style menu, there are options
boxes for selecting Bold, ltalic and Underlined text.

As text can be Bold, Italic and Underlined at the same time, selecting one
option does not de-select the others.

Using Dialogs with the Keyboard
Fora guide 1o using dialogs with the Keyboard, sec appendix [,

Conclusion
That concludes the Beginner's Guide to the PeW 16 programs. Please see
the following Reference chapter for information on using the Spreadsheet
program, and for a complete description of the menus and commands in all
the PeW 16 programs.
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The Desktop

The Tasks Menu
The Tasks menu is present in all the PeW 16 programs, and in the main
Desktop. It provides a method of switching directly from one program to
another,
The Tasks Menu contains entries for all the different PeW 16 programs,
including:
* The Word-Processor
* The Spreadsheet
* The Address Book
= The Diary/Alarm
* The Calculator

* The File Manager
In addition, the Tasks Menu inclodes three other important commands:

Switch Off
This command provides a method of switching off the PeW 16 using the
mouse, Selecting this command has exactly the same efTect as pressing the
Standby switch (see Switching Off). Note that once you select the Switch
Off command, you should not discanneet the mains power 1o the PeW 16
until the Standby button has stopped flashing, and glows red continuonsly,

Save and Confinue
Atany point while using your PeW 16, you may want to make sure that
your work is saved. You can use this command to save all documents and
files, whether in the Cabinet or on Disc. You can also choose this eam-
mand by pressing [ Tasks]+{F8] on the keyboard,

Run External Program
It is possible to buy or to write other programs to run on your PeW16,
This command allows you to run such external programis. ¥ou can run
external programs directly from a floppy disc, or from the Cabinet.
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Set Startup Options

The Setup Menu

The Setup menu on the Deskiop allows you to alter the information you
typed in when you first started up the PeW 16, This information includes
vour name and address (as used in the word-processor Templates), and the
type of printer you are using. For details of the Set Time & DateEnter
User Information andSelect Printer commands, please see the Seiting
Llp chapter at the beginning of this manual.

swlal = Sel gtuteg Oftens

You can sei your PeW 16 up in two different switch-on modes: you can
efther start up at the Desktop (the default setting), or you can cheose to let
the PcW 16 start up in the same condition as itwyg_hgi;]?_@ If
you choose to Restore the state ot last switch-ofT, the PeW 16 will run
whichever progrm was running when you last switched off, and will load
the document or file you were editing if appropriate.

Set Mouse Options

This command displays the following dinlog:

e
] '

==l

Daouble-Click

Some PeW 16 functions respond to a double-click of the mouse buttons (see
the Glossary for an explanation of double-clicking), The “Double-Click
Speed” option allows you to select how close together the two clicks of a
double-click must be in order 1o be recognised.

Reference: The Desktop

Swap Left and Right Buttons

The Mouse can operate in right-handed mode (the default), or in lefi-
handed mode with the left and right button functions reversed. If youare
lefi-handed and want to hold the mouse in your left hand, we suggest that
you swap the lefuright buttons. [f the buttons are swapped, all "Clicking”
must be done with the Right button.

Printer Setup

This command is only svailable if you are using one of the OKI LED Page
Printers. These printers have a number of controls which can only be
accessed from the PeW 16 screen. For a full explanation of these options,
please see vour OKI printer manual.

Print Density

The Print Density controls the amount of toner which the printer uses on
the paper. Choosing "Dark” printing puts more toner on the paper, which
gives a darker printed resull.,

Paper Thickness

The Paper Thickness option should be set according to the weight of paper
you are using in the printer. Using light paper, page printers often "curl”
the paper because of the heat used in the printing process. Selecting the
"Light" thickness option makes the printer heat the paper up less, and can
sometimes reduce the curling problem. Set this option according to the
thickness of paper you are using.

Cleaning Page Button

This button prints o single "cleaning page”, If vou have just changed the
OKI oner cartridge, or if you find that excess toner is being deposited on
your printouts, you can use this command to print some blank pages, which
should help to clean out any loose toner in the printer.

If printing a Cleaning Page does not solve the smearing problem, try
reducing the Print Density.

Drum Counter Button

The Drum Counter button should only be used when you change the
printer’s Drum. When an old Drum needs changing, this will be reported
when you try to Print from a program. When you fit a new Drum, you
must click this button to tell the printer that the new Drum has been fitted.
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Set System Options

This command allows vou to change some important aspects of vour

PeW 1 6's operating system.

Updating the Rosanne Operating System

This button allows you to load a new version of the PcW 1 6's operating
system from dise. PLEASE NOTE THAT YOU SHOULD ONLY USE
THIS COMMAND IF YOU HAVE BEEN SUPPLIED WITH A
PROPER PeW16 OPERATING SYSTEM UPGRADE DISC. The
documentation which accompanics the disc will provide more information,

Delete Font

This command allows you to select a font which is currently installed in
your PeW 16's Cabinet, and delete it. Once you have deleted a fon, it will
no longer be available for use in the word-processor,

If you do not use one of the PeW 16 fonts, it may be a good idea to delete it,
as Fonts occupy a large amount of space in the PeW 16's Cabinet. Deleting
a Font will make o substantial amount of Cabinet space available for the
storage of files, The two fonts supplied with vour PeW 16 can be rein-
stalled from the Rescue disc if you delete them, providing that there is
enough free space in the Cabinet to hold them.

Please note that if you delete all the fonts in your PeW16's Cabinet, you
will not be able to use the word-processor program at all.

Install Font

¥ou can use this button to add a new Font (or typeface, as used by the
word-processor), 1o your PeW 16' Cabinet, so that you can use it in the
word-processor, In order to add a new font, you must purchase a PeW 16
font dise. NOTE THAT YOU CAN ONLY INSTALL FONTS
WHICH ARE SPECIFICALLY DESIGNED FOR THE PcWI16. Do
not iry to install fonts from other types of computer system (such as
Truetype or Postseript fonts), as these will not work with your PeW 16,
Please see the documentation supplied with your font disc for more infor-
mation.

Screen Saver Delay

This option controls how many minutes of inactivity are required before the
screen saver sysiem comes into operation.

The Word Processor

Typing Text in a Document
When you type in the Word-Processor, the letters appear at the position
defined by the “Cursar”. If you want to insert text at a particular place in

the document, you must move the cursor to that position before You stan
Iyping.
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Moving the Cursor with the Keyboard

You can move the cursor short distances using the armow keys. [+] and
[-+] move the cursor one character to the left or right, and [1] and [4]
move the cursor up or down the screen by one line.

IT you want to move the cursar in lnrger jumps, you can hold down the
[Cirl] key. [Ctel]+[+—] and [Ctrl]+[—»] move the cuarsor left or right by a
whaole word,

You can also move the cursor using the group of keys above the arrow
keys. ‘The [Home] and [End] keys move to the beginning or end of a line,
and the [PgUp] and [PgDn] keys move the whale screen up or down the
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document. [Shift}+{PgUp] and [Shift[+{PgDn] move up and down the
document by a whole page.

Finally, [Crrl][+[Home] and [Ctri]+| End] move the cursor directly to the
beginning and end of the document respectively.

Maoving the Cursor with the Mouse "
To position the cursor using the mouse, simply move the mouse pointer
over the position you want, and click the left button. .
If you hold down the [Shift] key while clicking nnﬂwudumg?:mn,ﬂm
document is serolled upwards so that the line on which you clicked is
digplaved at the top of the screen,
Moving to the Markers with the Mouse - "Bookmarks" ]
If you have placed the Start or End markers (see &hﬂkg Texr nppm:lic],
you can move the cursor directly to either marker by holding down [Shift]
and pressing the Centre button (for the Start marker) or |h= Righlburmn
{for the End marker). Using the markers as "bookmarks" in this way
provides a useful short-cut for moving instantly from ane part of the
document to another,

Reference: Word-Processor

Selecting Text
[T you want to alter o section of the document (eg to move a paragraph of
text from one part of the document to another, or to make part of the text
appear in Bold style), you can Select the section you wanl to alter, then use
the commands in the menus to make changes to that section. To select
section, you must place the Start Marker at the beginning of the section,
and the End Marker ot the end.
Onee a section of text is Selected, it appears inverted, like this:
This swction of text is mot selected This section is not selected.

Many of the menu commands listed below operate only on a Selected
section of text, and other commands behave differently depending on
whether any text is Selecied when the commands are ysed.

Marking Text with the Keyboard
You can Select a section of text with the keyboard by placing the cursor at
the beginning of the section and pressing [Ctel[+H{M], then moving the
eursor to the end of the section and pressing [Creji+[1].

Marking Text with the Mouse
With the mouse, you can select a section of text by moving the mouse
painter to the beginning of the section and pressing the Centre button, then
moving the pointer to the end of the section and pressing the right button.
You can also place and remove the Start and End markers by elicking with
the mouse on the Mark button:

This button is located at the top right of the word-processor screen, [Fno
markers are placed, clicking it plices the Start marker at the current cursor
position. IFone of the markers is already placed, clicking the button places
the other marker at the current cursor position, and if both markers are
already placed, elicking the button will de-select the marked area.

De-Selecting: Cancelling a Selection
You can cancel a selection using the “Undo Selection™ command in the Edit
meni, or by selecting a different area: each Marker can only be in one
pasition at a time, i
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The Ruler and Tabs

Above the document editing area is a Ruler, so that you can see how wide
your text will be when it is printed. This widih is set by the size of paper
vou are using, and by the Margin seitings. The Ruler also acts as an

indicator, showing the Indent and Tab Stop positions:
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Because the word-processor al lows you to use different Indent and Tab
settings in different paragraphs, the Ruler's Indent and Tab indicators
always show the correct settings for the paragraph which currently con-
tains the cursor. 1f your document contains paragraphs with different
settings, you will see the Ruler indicators change as you move the cursor
from one paragraph to the next.

Indents

There are three Indent indicators, which show the Left, Right and 15t Line
indent settings of the current paragraph - the paragraph indent settings are
controlled using the Change Paragraph Format command in the Style
menu, Note that the measurements on the Ruler are relative to the Margin
seftings for the document as o whole, as set using the Ser Marginy com-
mand in the Document menu. This means that a paragraph with a Lefi
Indent setting of 0 will show its Left Indent indicator at 0 on the Ruler, as
shown above.

Tab Stops

The word-processor provides a system of Tab Stops - these are positions
scross the page 1o which you can move the cursor automatically using the
[Tab] key. Tab Stops are used 10 align columns of text vertically. Note
that all Tabs in the PeW 16 word-processor are the "Lefi-Align” type,
meaning that you can only use them to define the left edge of the column of
test. If you want 1o align a column of numbers with decimal points, you
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may need to use the "Numbers in Columns® option - sée the Champe Texr
Style command later in this chapter for more information, v

There are two types of Tab Stops - the Defaulr Tabs, which are spaced
evenly across the page, and the Uiser Defined Tabs, which are inserted
manually using the Change Tab Positions command in the Style menu,
Default Tabs are displayed as dotted symbols, while User-Defined Tabsare
displayed in solid black, Note that when you add a User-Defined Tab, any
of the Default Tabs to the left of the Tab you have added are removed.

If you want to sdd a User-Defined Tab Stop, instead of using the Change
Tub Poxivions command, you can simply click with the mouse on the Ruler,
ot the position where you want the Tab to be set, You can also remove n
User-Defined Tab-Stop by clicking on it in the Ruler. Note., hawever, thai
when you make changes to the Tab or Indent settings, these changes affect
only the current paragraph,

Using Paragraph Styles

You can use the word-processor to type and print lext in a wide variety of
styles and formats, However, each time you type a picce of text, it can take
& long time to choose all the different options for font size and style,
paragraph alignment and spacing, and the Tab positions. If you had to
select each set of options individually for each paragraph of text, the
process could be very time-consuming.

To make style and format selection easier, the PeW 16 uses "Paragraph
Styles". A Paragraph Style is just a complete definition of how the text in
4 paragraph should look, including the font size and style, the parngraph
alignment (left-aligned, centred, justified etc), the gaps above and below
each paragraph, the line spacing, the Tab stop positions, and so on. When
you have defined a Paragraph Style by choosing all of these options, you
can then "Apply” this whole style to any paragraph, using the "Use a
Paragraph Style” command,

Each document contains 21 Paragraph Styles, and you can give them
names which describe what they do - the names can be a maximum of 12
characters long.

Amatrad PCW 6.
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Style Options: Bold, Italic and Underlined Text Text Size and "Point Sizes"
At the top of the word-processor screen are three "Style™ buttons, for You can use the word-processor to type text in o range of sizes. The size of
selecting Bold, Italic and Underlined text, You can choose any or all of printed text is normally measured in “Points” - one Paint is approximately
these Style aptions simultaneously. Y72 inches. The range of type sizes available in the word-processor is as
follows:
BOID o
To type in Bold text, simply click the Bold button, or press [Curl]+HB]. ‘o E PO
You will see the button become highlighted, and any text vou type while the + 10 Point
button is highlighted will appear in Bold. To revert to normal text, just $1 Peint
click the Bold button again, or press [Ctrl[+[B] again. - 12Pei
The Italic and Underline buttons operate in the same way, using [Ctel]+{1] S
and [Cirl]+[U]. = 14 Point
Mote that you can‘also change the Style of a section of text, by Selecting it « 18 Poi
{mee above), then clicking the style botton you want. 1T vou use the buttons oint
with nio text selected, the button settings affect any text you type from then .
on. [Tyou use the buttons with some text selected, the button settings - 24 PD lnt

affect the selected text,

* 36 Point

e 72 Point

For more information on choosing a Point size. see the Style Menu com-
mands later in this ¢ .
RS2 20

——
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Menu Commands
The Document Menu

This menu contains commands for controlling aspects of the whole docu-
ment, including the commands for Editing, Saving and Printing them.
Discs, the Cabinet, and Folders

A word-processor document can be stored in the Cabinet, or on a floppy
disc. When you are creating a new document or selecting a stored one for
editing, use the Option Boxes labelled “Cabinet” and “Disc™ to choose the
document’s location. [f you want to store your document on floppy disc,
you must insert a disc in the PeW 16's disc drive before you choose the
Disc button,

Both the Cabinet and a PeW 16 floppy disc contain sixteen “Folders™, and
You can chioose to store your document in any one of these. [T you activate
the “Folder” drop-list (by clicking on it, or by pressing [Tab] until it is
highlighted then pressing [Space]), you will see a list of the folders avail-
able: if you have selected Dise, you will see the names of the folders on the
dise, and if you have selected Cabinet, vou will see the names of the folders
in the Cabinet. Wote that you can change the names of folders using the
File Manager program.

Start New Document

When you choose to Start 8 New Document, the word-processor automati-
cally saves the existing document. It then displays the following dialog:

You should first choose the location for the new document you want to
create (see Storing Your Work in chapter 2 for more information about how
your PeW 16 stores documents and other files), then type a name for it 1f
you just type the name without changing the location, the document will be
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stored in the Default Storage Location - this is normally Folder number
One in the Cabinet, but you can change it using the File Manager program.
Document names can normally be up to 32 letters long. 1f vou try to type a
letter but it does not appear, this means that the letter you have typed is not
allowed ina document name. Characters which cannot be used in docu-
ment names include the question-mark (7), the asterisk (*), the slash char-
acters (\ and /), the bar (]), and the full-stop (.).

Omnce you have entered these details for your new Document, press /. You
will then see a dinlog which allows vou o choose the Templute on which
the new document will be based. Once you have selected o Template and
pressed f, you can start typing the text for your new document.

The PeW16 is supplied with a number of Templates built-in, but you can
alter these Templates to suit your own needs, or design your own new
Templates from scratch. For more information about creating Templates,
see the Mike New Template command.

Edit Stored Document

This command allows you recall a stared document, so that you can make
changes to it or reprint it. When you choose the Edit command, the pro-
gram displays a dinlog allowing you to choose a stored document to edit:
for o guide to using the Disc / Cabinet selector and the Folders list, see
Step 6: Editing a Stored Document in chapter 2.

When you choose a document and press f, the document is Joaded info the
word-processor, and you can then edit it as normal.

Save As

This commuond allows you to save the current document under a different
name, and/or in a different location. 1t displays a dinlog which allows you
to type o document name and choose a location, just as in the Star New
Document command above, When vou press , the current document is
saved in the new name and location.

Mote also that the old decument is left intact, stored under its old name.
This means that you can reload and edit the old verdion of the document
even after you have made changes to the new one.
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Revert to Saved

This command abandons the current version of vour document, and
reloads the last version which you saved. 1t allows you to undo any
changes you have made since the last time you saved your document. It's
a good idea to save your document regularly, using the “Save and Con-
tinue™ command in the Tasks menu.

Import Document

This command allows you to convert adocument created using a different
waord-processor or computer, and make it into a PeW 16 document so that
you can use it.

The Import command displays a dialog like this:

In order to Import a document, it mast be stored on a dise formatted as
DOS, CP/M or Locoscript. The illustration above shows how a typical
DOS dise with files stored in its Root directory might appear,

Importing Documents from PC-Compatibles

Ifthe dise is DOS format, the file containing the document must be stored
in the disc’s “Root” directory. The Import dialog displays a list of all the
files in the Root directary - if the file-name you want does not appear in
the list, it is not stored in the dise's Root direetory, and eannot be Imparted
unless you transfer it to the root directory using another compliler.
Documents from PC-based word-processars must be stored as plain
ASCI text, or in “Rich Text Format” (sometimes called “RTF”), if you
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want to import them into your PeW 1 6s word-processor. You will nar-
mally get the best results by Exporting the document from your PC word-
processor as an RTF file, rather than as ASCII- RTF files include style
and formatting information, while ASCII files contain only the plain
document text. You can normally create ASCIor RTF versions of docu-
ments using “Save As” or “Export” commands within your PC-based
word-processor,

Note that RTF comes in different “flavours”, and there are small differ-
ences between the RTF Mavours used on different computers and operating
systems. The PeW | 6 supports the Microsoft Windows flavour of RTF, so
importing RTF files from other sources may produce small errors in the
conversion of particular characters.

Importing Documents from Locoscript and CP/M

If you created the file using an earlier PeW 16 computer (the PCWE256,
8512, 9256, 9512 or PCW10), the disc containing the document will be a
CP/M or Locoscript format dise. Your PeW |6 word-processor can import
documents from any PCW version of Locoscript, and from other PCW
word-processors such as Protext, providing that the documents are stored
on 345" disc. (If you need to transfer documents from 3" PCW discs,
please contact Amstrad Direct at the address at the beginning of this
manual, for information about the "Locolink® file transfer system. )

When Importing from a CP/M or Locoseript dise, you should be aware that
documents can be stared in any of the 16 “Groups”™. When you choose the
Import command and insert a CP/M or Locoscript dise, the Impont dialog
shows a list of all the documents in Group 0 on the disc - if the document
you want te Import is in a different Group, you can change Groups using
the “Groups™ drop-list. Note that Locoscript documents are stored in
Group numbers 0 to 7, which can have names instead of numbers. {Any
documents in Groups B-15 on a Locoscript disc are “Limbo” files.)

Once you have selected the correct Group, choose the name of the file you
want to Import from the list of file-names:

Export Document

Exporting a document means saving it on a disc in a format which can be
understood by another computer or word-processing program. The PeW 16
word-processor can export in two different file formats, called “ASCII™
and *Rich Text” (or “RTF”) formats.

Aurntrad PCW (&
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ASCII Files

ASCII is an American Standard code, and is understood by virtually all
word-processors, and many other computer programs. It is the most
widely-used way of transferring text between different computers and
systems. However, the ASCII standard does not include many of the
characters you can type on the PCW: although the A-Z alphabet, numbers
and hasic punctuation characters (commas, full-stops etc) will be trans-
ferred correctly using ASCI, some accented characters and less commonly
used letters (such as musical symbols, arrows ete) are not standard ASCII
characters, and may be omitted from the exported document. More impor-
tantly, ASCILis a “plain text” format - it contains all the letters and words
in the document, but does not include any information about how these
letters are supposed to look. When Imported, an ASCII document will use
only ane font, and will contain no Bald, ltalic or Underlined text, and no
Tabs or Indents, This kind of information can only be imported using the
Rich Text Format. .

Rich Text Format Files

Rich Text Format (RTF) is a more versatile format, and will include all
chiracters from the document, and some formatting information including
Headers and Footers. Although it is not possible to make your PeW 16
document look exactly like the original document from the PC word-
processar, RTF format provides the best way of converting documents
between different types of computer.

Set Paper Size
This command allows you to define the paper size for your document:

You can choose to use A4 paper (29752 1 0mm), or the American Letter or
Legal paper sizes by clicking the appropriate boxes. You can also specify
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your own custom paper size, by clicking the "Custom" box, then entering
the dimensions you want in the Height and Width boxes, or use the Jj
spinner buttons. When using Custom sizes, note that the paper cannot
exceed 216mm in width, or 356mm in height.

Units

The paper size can be entered in any units. Providing that you add the
letters “mm™, “cm" or “in™ after the number, the size will be automatically
converted info the units set by the Ser Preferences command,

Please note that your printer may have other limitations which may prevent
it from using particular paper sizes: please consult vour printer manual for
maore information.

Set Margins
This command allows you to set the Margins between the edge of the paper
and the edges of the printed fext:

1t also includes an option for using Single or Facing pages. With Single
pages selected, each page uses the same margins at the left and right.
Cutsate
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Facing pages are designed to be viewed in pairs, like the pages in a book or
anewspaper. Pages with even page-numbers are lefi-hand pages, and
pages with odd page-numbers are right-hand pages. Instead of having Left
and Right margins, Facing pages have Inside and Outside margins, as
shown above.

When using Facing pages, you can use different Headers and Footers for
left and right pages. In the illustration on the previous page, you can see
that the header on the left-hand page is left-aligned, while the header on the
right-hand page is right-aligned. This means for example that you can
place page-numbers or other information in a header or footer so that they
always appear al the outer edge of the page, as shown.

Headers / Footers

This command allows you to enter text for your document’s Headers and
Footers. It also lets you control the Header and Footer printing options.
When you choose the command, the program displays the following dialog:
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Setting the Header and Footer Printing Options

There are four independent printing options for Headers and Footers.

The first two options are “Print Headers™ and “Print Footers™. These
conirol whether the Headers and Footers are printed at all - switching these
options off means that Header and Footer text will never be printed.

The second two options control whether to print the Header or Footer text
on the first page of your document, Because the first page of a document is
often a title page, which is laid out differently to the other pages, it is often
useful to omit the Header and/or the Footer from the first page, while still
printing them on subsequent pages.
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Editing Header and Footer Text
The “Editing” panel contains buttons which let you Edit either the text used
in the Header or the Footer. If your document uses Facing Pages (see Ser
Margins abave), the panel also contains Option Boxes to select whether to
edit the Header/Footer text for Left pages, or for Right pages.
When you choose one of these buttons, the screen changes to allow you 1o
edit the Header or Footer you have chosen. The top of the screen looks
something like this:
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This screen operates in a similar way to the normal document editing
sereen. You can fype the texi for the Header or Footer you chose in the
previous dialog, and you can set the text size and style, and the Tab ruler
settings, using the commands in the Style menu. You can also insert the
current Time and Date, and other characters and numbers, using the
commands in the Insert menu.

Note that while Headers and Footers can contain any amount of text, they
can only be a single paragraph - you cannot have more than one paragraph
in a Header or Footer. This means that the [Return] key does not work as
normal when editing Headers or Footers.

Automatic Page Numbering
As well as plain text, Headers and Footers can also contain a special code
for printing the current page number, so that you can automatically include
a page number in the Header or Footer on cach page. You can insert this
code anywhere in the Header/Footer text by clicking the PAGE NUMBER
button, or by typing -

{Fage}
- at the point in the text where you want the page number to appear.
This code appears on the editing screen as “{Page)”, as shown in the
illustration abave. When you print the document, it is replaced automati-
cally by the correct number on each printed page.
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For example, if you are editing a Fooler, and you type the word “PAGE",
then a space, then click the PAGE NUMBER button, the screen will show
the text in the footer like this...

PAGE {Page}
«..but on the final printout, the word-processor will print...

PAGE 1 (at the bottom of page 1)

PAGE 2 (at the bottom of page 2)
_-and 50 on,
When you have finished editing your Header or Footer text, clicking the
Finished button will return you to the original Headers and Footers dinlog.
You can then choose to edit a different Header or Footer (remember that
documents which use Facing Pages contain two Headers and two Footers),
set the printing options, or click OK to return to your document.

Make New Template from Document

This command allows you to create your own Template, using the settings
from the current document. When you choose the command, the program
asks you 1o type a name for the new Template. Once the Template has
becn created. it will appear in the Templates list whenever vou Start a new
document.
A Templaie includes all the options set by the Paper Size and Margins
dialogs, the document Header(s) and Footer(s), and the list of Paragraph
::}'Ins, Whenever you use the new Template, the settings of all these will
recalled.

Including the Document Text
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As well as layout and style information, Templates can also include text. 1
you choose the Make New Template command when the current document
already has some text included in it, you will be offered the option to
include this text in the Template as shown above, If you choose to include
the text, any new documents based on the Template will have this text
automatically inserted af the beginning, though you can easily delete it from
the new document once you start editing.
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word Count

This command counts the words in your document, or in the currently
selected text. Ifyou use Word Count with no text selected, the command
simply reports the number of words in your document. 1f you use Word
Count whille text is selected, you can choose whether to count the words in
the whole document, or just those in the selected section.

Check Spelling

When you choose this command, the following dialog is displayed:

Y ou can choose whether to check just the word in which the cursor is
currently positioned, or check the spelling in the whele document, You can
also choose to check from the current cursor position until the end of the
document.,

Ench word is checked in two difTerent dictionaries; the standard dictionary
and the User dictionary. The standard dictionary contains approximately
48,000 commaon words, but you can also build up your own custom dic-
tionary - see Adding a Word to the User Dictionary below..
Correcting a Misspelt Word

When the program comes across an unknown word during a spell-checking
run, it displays the following dinlog:
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The dialog shows the unknown word, and includes a list of the words from print Preview

the standard dictionary which match it most closely. Ifthe unknown word
is spelt wrongly, you can type the correct spelling in the Replace With box,
or click on the correctly-spelled word in the list, then click the Replace
button (or press [F2]). The misspelled word is then replaced with the
correct one. If you selected the Whole Document or From Cursar aption,
the program continues looking through the text until it finds another un-
known word, or until it reaches the end of the document.

Adding a Word to the User Dictionary

I the unknown word is correctly spelled, it must be missing from the
dictionary: this may be because it is a special word (such as a name), or
same technical term (like “PCW™), which would not be included in a
standard dictionary. To prevent the spell-checker from stopping and asking
you to correct the spelling every time it finds such a word, you can add
words to the “User Dictionary”, which is also used by the spell-checker if it
is unable to find & word in the staridard dictionary.

To add an unknown word to the User Dictionary, simply click the Add
button (or press [F3]) when the spell-checking command reports the word
as unknown, Once you have Added the word to the User Dictionary, it will
always be recognised by the spell-checker, and will not be reported as an
error.

Skip

Click this button (or press [F1]) to tell the spell-checker to ignore the
unknown word, and continue checking the document.

Re-Paginate Document

As you edit your document, the word-processor program normally alters
the display to reflect the changes you have made. However, when you
insert text into an existing paragraph, the program must create a new,
empty line for your to type on, even when there will be no empty ling in the
finished document.

Re-Pagination is the process whereby the program rearganises the screen
display to correspond exactly with how the text will be printed - the docu-
ment is always re-paginated automatically before it is Printed or Saved, but
if you want to force the program to re-paginate while you are editing the
document, you can use this command to do so,

This command displays a picture of how a page {or a pair of facing pages)
from the current document will appear when Printed. Print Preview isa
uzefitl way of checking that the printout is correct without actually print-
ing. because it includes the page Headers and Footers.

The Print Preview screen has buttons for moving forwards or backwards
through the document, and a Print button which acts asa short-cut to the
Frint command,

Print Document

This command prints the current document. When selected, it displays the
follovwing dialog:

If you press ¢ without changing any of the Print dialog options, the pro-
gram prints & single copy of the whole dn:umml.._ You can use the options
in the dialog to print multiple copies, and/or to print only the current page
(e where the cursor is located when the Print command is selected). )

The third option appears as a pair of boxes for setting Draft or Quality
printing. Depending on the printer type, you may be able (o choose
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“Diraft” print which uses less ink or toner than a Quality print, and may be
faster, However, not all printers have this feature, and changing this option
may not make any difference 1o vour printout.

Mail-Merge Printing

Mail-Merge printing is a method by which a standard letter can automati-
cally be set up to include personal details of different people or companies.
It uses the information stored in the Address Book entries to merge details
such as names and addresses into a letter or other document, then prints a
separate, personalised copy of the document for each recipient.

There is a Mail-Merge code for each “field” in an Address Book entry: the
process of Inserting Mail-Merge Codes in your document is explained
below. [Fyour document includes any Mail-Merge codes, the Print com-
mand has an extra dialog which allows you to choose which of the entries
in the Address Book are used to create printed documents.

Choosing Entries from the Address Book

When you choose the Print command with a document which includes one
or more Mail-Merge codes, the normal Print dialog is displayed as de-
scribed above, then a second dialog appears showing a list of the entries in
the Address Book:

Reference: Word-Processor

¥'ou can choose which entries to include in your Mail-Merge print by
elicking on them in the list, or highlighting them using T4 and [Space].
You can also choose to include all of the entries using the SELECT ALL
button, ar you can cancel all the selections you have made using the
DE-SELECT ALL button.

When you have made your selections for Mail-Merging, press o to begin
printing. The word-processor will now print a separate copy of the docu-
ment for each entry you have selected, and will replace each Mail-Merge
code in the document with the contents of the relevant field in each Address
Book entry,

Abandon Document

This command allows you to exit from the word-processor program
without saving the current document. This operates as an alternative to
pressing [Stop] - it allows you to refurn to the Desktop without over-
wriling an earlier version of the current document.
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The Edit Menu
Many Editing commands can operate only on the corrently Selected section
of text, and may be unavailable if no text is selected. Commands which are
unavailable are "greved-out”,

Cut Selection to Scratchpad
This command is only available if a section of text has been selected, The
command deletes the selected text from the document, but stores it on the
Seratchpad. The textcan then be Pasted back into the document in a
different position: see Paste below.
Once text has been Cut onto the Seratchpad, it remains there until o differ-
ent section is Cut or Copied, at which point the existing Scratchpad con-
tents are discarded,

Copy Selection to Scratchpad
This command is only available if a section of text has been selected, The
command copies the selected text onto the Scratchpad, but unlike the Cut
command above, it leaves the selected texi itsell intact in the document.
Thie text ean then be Pasted into the document in a different position: see
Paste below.
Once text has been Copied onto the Scratchpad, it remains there until a
different section is Cut or Copied, at which point the existing Scratchpad
contents are discarded.

Paste from Scratchpad
This command is only available if there is 1ext on the Seratchpad - you can
place text on the Scratchpad using the Cut and Copy commands as de-
scribed above.
When you choose Paste, a copy of the Scratchpad text is inserted into the
document at the curreni cursor position, just as if it had been typed at the
keyboard. After Pasting, the text remains on the Scratchpad, and you can
Paste it into the document as many times as you like.

Delete Selection
This command simply deletes the selected text from the document.
1T you accidentally Delete a section of text which you want to keep, you
can usually recover it by pressing [Undo] immediately. Note that onee you
have used any other menu commands or edited the document affer an
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accidental Delete, the Undo command will be unable to recover the deleted
lext.

Store Selection as Phrase

Your PeW 16 can store up to eight *Phrases”, and this command is used 1o
Store the currently selected text in one of thesc cight Phrase numbers.
Once stored, a Phrase will remain available until you Store a different
seetion of text in the same slot. A Phrase can contain up to 250 characters,
The Store Phrase command displays the following dialog:

This dialog lists the eight Phrase numbers (F1-F8), and shows their current
contents. To store the currently selected text as a Phrase, you must choose
a Phrase number from the list using the T4 keys or by pressing [F1]-[F8],
then press . When you store o new Phrase, the previous contents of that
Phrase number are discarded.

Note that the Stored Phrases are part of the word-processor as a whole, not
part of an particalar document. When you make a change to the list of
Phrases, the new list will apply to all future documents.

Hot-Keys for Storing Phrases

While editing a document, you can Store the current selection as a Phrase
by pressing [Task]+{Ctrl]#[F 1-8], instead of using the menu command.
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Find Text
This eommand searches through your document for a particular word,

phrase, or sequence of lefters or numbers. When you select the command,

it displays the following dialog:

When you have typed in the text you want to Find and pressed /, the
progrm will begin searching through the document, starting from the
current cursar position.

When it finds an occurrence of the text you entered, it highlights the text,
and the screen changes to look like this:
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In this “Text Found™ state, the Find command is still operating, so you
cannot choose a different command or access the menos until you have
cancelled Fimd,

At the top left of the screen, the program displays the text vou have entered
in the box labelled “Finding:™. You can click on this box (or press [Tab]
repeatedly until it is highlighted) then alter the text. 1T you alter the Find
text, pressing one of the Find buttons will make the program search for the
mew lext you have entered.

If you press STOP, the Find command is cancelled and the screen retums to
its normal editing mode, but the cursor remains at the text which was
Found.

If you press FIND NEXT, the program continues searching until it finds
anather occurrence of the text, then stops and highlights that occurrence.
By repeatedly pressing the FIND NEXT button, vou can find every occur-
rence of the text in your document.

1T you press FIND FIRST, the program searches for the text starting at the
beginning of the document, instead of from the current cursor position,
Pressing HELP displays a Help sereen as normal - Help is provided as a
buiton because the Menu Bar cannot operate while the Find command is in
progress.

The "Match Case® Option

When you first choose Find and type in your text, you can choose the
Match Case option. Upper and Lower Case mean capital and small letters
respectively: when Match Case is selected, the command will only Find
those incidences of the text where the case matches exactly what you typed
in the Find dialog. 1f you leave the Match Case box blank, the command
will find all incidences of the text, regardless ofwhether the letters are in
the same case as those you typed
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Replace Text

This commanid searches through your document for a word or phrase which
vou enter, then offers you the option to replace it with a different word or
phrase. When you select the Replace command, it displays the following
dialog:

First type the text vou want to find; then press [Tab] (o move to the Re-
place box, and type the text with which you may want to replace it. You
can also choose the *Match Case™ option: see Find above.

When you press o, the program will search forwards from the current
cursor position. When it finds an incidence of the text to be replaced, it
displays the following screen:
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In this “Text Found” state, the Replace command is still operating. so you
cannot choose a different command or access the menus until you have
cancelled Replace.

The top left corner of the screen displays the two Find and Replace texts.
¥ou can select and edit these by clicking on them, or by pressing [Tab]
repeatedly until the text you want to edit is highlighted. The Found text is
highlighted on the main screen.

If you press STOP, the Find command is cancelled and the screen retums o
its normal editing mode, but the cursor remains at the text which was
Found. Note that any text Replacements you have made since the Replace
command was selected are kept, and cannot be undone.

If you press REPLACE, the Found fext is replaced by the Replace text, and
program automatically continues searching until it finds the next occuir-
rence of the Find text.

If you press REPLACE ALL, the program immediately searches through
the remainder of the document, and automatically replaces all occurmences
of the Find text with the Replace text, without stopping to confirm each

one.

If you press FIND FIRST, the program starts searching from the beginning

of the document, instead of from the current cursor position,

If you press SKIP, the highlighted text is left intact, and is not replaced.
The program continues searching through the document for the next occur-
rence of the text.

Pressing HELP displays a Help screen as normal - Help is provided as a
button because the Menu system is disabled while the Replace command is

operating.

Select Whole Document

This command provides a quick way 1o Select the whole document, by
automatically placing the Start Marker at the beginning of the document,
and the End Marker at the end.
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The View Menu
The View menu commands affect the way in which the document is dis-
played on the screen, but they do not make any changes to the document
contents. Changing View commands may make the document appear
different on the screen, but they have no effect on the document itself.

Tabs and Returns
This command displays Tab and Return characters on the lext screen as
symbols, so that you can see where they occor in the text. Retumn charae-
ters are added whenever you press the [Retum] key to start b new para-
graph. The symbaols look like this:

d Return
—+ Tab
Spaces .

This command displays a small circle in all the Spaces between words,
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The Insert Menu

Overwrite Mode
This command switches between Insert and Overwrite modes,
When the word-processor is operating in Insert Mode (the default), as you
type new characters at the cursor, they are Inserted into the document, and
any text which appears after the cursor moves down the document to make
room for them.
In Overwrite Mode, the new characters replace the old characters, so that
as you type each character, the character ahead of it is deleted.

Insert Another Document
This command operates exactly like the “Edit Document” command. Tt lets
you choose a document from any Folder in the Cabinet or on disc. When
you press ¢, the document is inserted at the current cursor pasition, Just as
if you had re-typed it. Note that the Paragraph Styles and formatting
information from the inserted document will not be preserved - instead, the
document text will be formatted according to the current Paragraph Style in
the new doctiment.

Insert Stored Phrase
This command displays a list of the phrases you have previously Stored
(see the Store Selection as Phrase command in the Edit menu), so that you
can choose ane to Insert:

You can select a phrase in the list using the T4 keys, or by pressing [F1]-
[F8]. When you press , the phrase you selected is inserted in the doci-
ment at the current cursar position.
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Hot-Keys for Inserting Stored Phrases
While editing a document, you can also Insert a Stored Phrase directly by
pressing [Crrl [+ F 1-8], without using the menu command.

Insert Today’s Date
This command inserts the date at the current cursor position. The date is
taken from the PCW's own internal clock. 1tis entered as ordinary text,
which you can edit if you wish,
The format of the date can be changed using the Preferences command in
the Options menu - you can choose from a number of different formats,
including numeric (eg 31/01/96), or & more fully worded format (eg 315t
January 1996).

Insert Current Time
This command inserts the lime at the current cursor position, The time is
{aken from the PCW's own intermal clock, at the moment at which you
select the command.
The format of the time can be changed using the Preferences command in
the Options menu - you can choose from a number of different formats,
including options for | 2-hour (eg 06:30pm ) and 24-hour (eg 18:30).

Insert Mame/Address
This command allows you to insert an entry from the Address Book into
your document. 1t displays a list of all the Address Book entries, and
allows you to choose one,
¥ou can select an entry from the list by clicking with the mouse, or by
using the T4 keys, then press 1o insert the entry into the document. All
the fields from the entry will be inserted, except the Notes field - after
inserting the entry, you may want to delete any information you da not
want to be included in the document.
¥ou could use this feature in preference to Mail-Merge if vou want to send
 letter to a single recipient.

Insert Calculation
This command pops up the Caleulator, and allows you to use it in the
normal way to caleulate a number. When the caleulation is complete, and
youclick the Exit button (or press ) to exit from the Caleulator, the resull
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of the calculation (fe the number which was on the caleulator display when
vou chose Exit) will be inserted into the document.

Inserl Character

This command allows you to choose a character to insert into the docu-
ment. It displays the following dislog:
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Most characters (such as the standard A-Z alphaber), are printed on the
keyboard keys, and even those which are not printed on key-tops (such as
bullets or diphthongs, or accented characters), can still be typed by refer-
ring to the table of charncters in appendix E.

Newvertheless, it is still useful to be able to call up a display of all the
characters on-screen, and to select one with the mouse or with the key-
board. This command displays a table of all the characters avai lable,
allows you to select one, and to add an accent 10 it if vou wish. When you
press OK, the eharacter you have selected will be inserted into the docu-
ment.

To select a character or accent from the table using the MOUSE, simply
elick on the one you want. With the KEYBOARD, use the [« 11—
arrow keys to choose a character, and [Shift}+[«T4-] to choose an
accent.
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Mote that two characters in this dialog are invisible. The first entry in the

The Style Menu
chiracter table is the Space, and inserting this has the same effect as typing

The Bold, Italic and Underline Commands

aSpace. The first entry in the list of accents (the ane highlighted in the
illustration above) is blank, and gives an unaccented character when
selected.

Insert Mail-Merge Code

This command allows you to insert a “Mail-Merge Code” into your docu-
ment. Mail-Merging allows you 1o include information from Address Book
entries in your document, so that you can address the same letter to several
different people sutomatically. For more information about Mail-Merge
Printing, sec the Print command above.
When you choose to Insert a Mail-Merge Code, the program displays a list
of the "fields” in the Address Book. Choose a field from the list by clicking
on it or using the T4 keys, then press o to insert the code,
Mail-Merge codes appear in the text of yvour documents in brackets - for
example, if you choose t Insert the "NAMEI]" field. this will appear in the
text as

[NAME 1)
Onee you have Inserted a code, you can delete it just by deleting the char-
ncters as if the code were ordinary text. 1f you delete some of the code
characters but leave some behind (eg if vou delete " {NA" and leave only
“ME_I}7, this will no longer be recognised as a Mail-Merge code, and will
be printed as i it were ordinary text.

These commands change the style of the text in your document, and have
the same effect as clicking the Bold, Italic and Underline buttons at the top
of the word-processor sereen (see Stle Options at the beginning of this
chapter). The commands and the buttons behave differently depending on
whether you have selected any text in the document when vou choose the
command:

If a block of text is selected...

Choosing the Bold cormmand will normally make all of the selected rext
bald. However, if the beginning of the selected text was already bold,
choosing Bold will un-Bold the text. Choosing the Bold command repeat-
edly will make the selected text switch back and forth (or “toggle™) between
the bold and non-bold states.

If no text is selected...

Choosing the Bold command will make the typing style Bold, This means
that any text which you type from now an will be Bold. To stop typing in
Bold, simply choose the Bold command again.

The Italic and Underline command operate in the same way as the Bold
commund.

Use Larger/Smaller Font

These two commands change the text size, making the characters larger or
smaller. The PCW allows you to use up 1o ten different text sizes, from
6-point up to 72-point. (Type is always measured in “points” - there are 72
points to an inch, so 36-point type is about half-an-inch tall.)

Like Bold, ltalic and Underline, these commands behave differently de-
pending on whether there is any text marked. 17 text is marked, the com-
mands affect the font size of the marked text. 1f no text is marked, the
commands affect the font size of the next charcters you type,

Indent Paragraph

This command is a short-cut method of “indenting”™ a paragraph from the
left margin. When you choose the Indent command, the Left Indent setting
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of the paragraph containing the cursor is moved inwards, 1o the nexi tab
position.

Change Text Style

This command allows you to change all of the Style characteristics of your
text. Ifthere isany text selected, the command affects the selection, but if
o texl is selected, the commuand sets the style options for the nexi charac-
ters you Lype.

The command displays the following dialog:

The different settings you can upply using this dialog are as follows:

The FONT setting can be changed 1o select any of the fonts you have
installed in your PeW 16, By default, the PeW 16 has "Swiss" and "Times"
fonts, but fonts ean be added or removed using the System Setup com-
mand, inthe Desktop's Sctup menu.

The POINT SIZE setting controls the size of the characlers. For an
explanation of Point Sizes, see page 63. '

BOLD, ITALIC and UNDERLINE styles can be applied by clicking the
appropriate boxes.

The NUMBERS IN COLUMNS setting can be used to ensure that
vertical columns of numbers are properly aligned,

This is necessary because the PCW's typefaces are spaced proportionally,
so that narrow characters occupy less space than wider ones. 1 you want
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1o create vertical columns of numbers, you need to select "Numbers in
Columns® 1o align the digits vertically.

L 110800
461135 #1135
aena2 2232222

The NORMAL / SUPERSCRIPT / SUBSCRIPT boxes allow you to
choose one of these three positions for your text. The text will appear as
follows:

Thigisnormal texl. Thehapencipiel o, et

Change Tab Positions

This command allows you to change the positions of the Tab Stops for the
current parngraph.

Even if vou do not set any Tab Stops yourself, the word-processor auto-
matically adds its own default Tab Stops at equal intervals across the page.
11 o add any of your own, all the defisult tab stops to the left of the one
you sdded are removed. The Tab Stop positions for the current paragraph

are indicated on the Ruler Line above the text:

Anidn
[ [ENE O N @
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Whien you choose Change Tab Positions, the command displays the follow-
ing dialog:

¥ou can add a Tab Stop at any position by setting the position you wani
using the NEW TAB AT spinner (or by typing the position), then clicking
the ADD NEW TAR button {or pressing [A])

You can delete a Tab Stop by choosing it from the list, then clicking the
DELETE SELECTED TAB bution (or pressing [D]). Note that the list
only displays tab-stops which have been entered by hand - you cannot
delete the default tab stops.

Change Paragraph Format
This command allows you to change the format settings for the current

paragraph.

o e e

The settings in this dialog are as follows:
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SPACE ABOVE controls the amount of vertical space which is left empty
before the paragraph text begins.

SPACE BELOW controls the amount of vertical space which is left empty
at the bottom of the paragraph, before the next paragraph begins.

NOTE: the vertical space which will be left empty between one paragraph
will be the Space Below the first paragraph PLUS the Space Above the
second paragraph.

The LEFT and RIGHT INDENTS are the spaces left emply at the sides
of the paragraph. These are measured from the document Margins, which
are set using the Ser Afargins command in the Document menu.

The 18T LINE INDENT i3 the same as the Left Indent, but applies only
to thee first line of the paragraph. This allows the lefl edge of the first line
to be different from the rest of the lines in the paragraph, so that youo can
indent the first ling, ar create a “hanging indem™.

Each paragraph can be ALIGNED to the LEFT, RIGHT or CENTRE,
or can be JUSTIFIED to give straight margins on the left and right edges.

Finally, the LINE SPACING for the paragraph can be set to SINGLE,
1%, our DOUBLE.

Use a Paragraph Style
This command allows you 1o apply a Paragraph Style to the current para-
graph, or to a Selected block which may contain several paragraphs. The |
command displays this dialog:

oy, e e
Click on the drop-list to display a list of the Paragraph Styles in your
document, then cheose a style using T4, and press /. The chosen Para-

graph Style will beapplied to the paragraph which currently contains the
cursor,
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Edit a Paragraph Style

This eommand allows vou to alter the settings of a Paragraph Style - sec
the beginning of this chapter for an introduction to Paragraph Styles. Each
Paragraph Style includes sestings for the Text Style, the Paragraph Format,
and the Tab Positions, so that it forms a complete description of a para-
graph's appearance.

When chosen, the command displays the following dialog:

First, you must choose which Paragraph Style you want to change, by
choosing i style name from the drop-list at the top of the dialog,

Once you have chosen a Style to edit, click one of the buttons to choose
which setting you want to change. The buttons for TEXT STYLE, TAB
POSITIONS and PARAGRAPH FORMAT display the same dialogs as

the commands of the same names - see the descriptions of these commands

earlier in this chapter for more information about each dialog.

The dialog also contains a fourth button labelled STYLE NAME, which
allows you to change the name of the Paragraph Style you are editing.
Finally, there is a drop-list for the FOLLOWING STYLE. This allows
vou o choose which Paragraph Style should be applied automatically to
the next paragraph. once the Return key has been pressed. For example, if
vou have a Paragraph Style for Headings, you might want to set the Fol-
lowing Style to be a Body Text style, so that Body Text is automatically
applied 1o the paragraph below the heading,

One option in the Following Style list is for SAME STYLE - this means
that the following paragriph will be in the same style as the previous one,
and is a suitable option for paragraph styles set up for the main body of
document text. 1f Same Style is selected, when you press [Return] to start
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a new paragraph, all the paragraph format and text style options which
were operating at the position where you pressed [Return] will be used in

the new paragraph,

store Paragraph As Style
This command allows you to create a new Paragraph Style using the style
and format settings of the paragraph which currently contains the cursor.
The command displays the following dialog:

Because there are only 21 styles available, when you create a new Style,
you must replace an existing one. As well as providing a box for the name
of the new Style, the dinlog also contains a drop-list of the 21 styles, so
that you can choose which one to replace, '
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The Options Menu The Spreadsheet
Set Preferences what is a Spreadsheet?

This command allows you to set some of the general user-options for the
word-processor. Note that the options you set in this dislog will apply to
the word-processor program in general, every time you use it. They are ng
part of the document, but part of the program itself,

The command displays the following dinlog:

A spreadsheet is a kind of calculator - it lets you enter numbers into its
“cells”, perform caleulations on these numbers, then display the results of
these caleulations in other “cells”™. You can also use the cells to display
text instesd of numbers - this is handy for adding labels or other informa-
tion to your spreadsheet.

The vertical “Columns” of cells are labelled using the letters A o Z, and
the horizontal “Rows™ are numbered 1 1o 250, This means that you can
refer to each cell by a “cell reference™ which is a combination of its column

and row,
A B c D B F
1 Al Bl Cl ol El Fl1
2 A2 B2 c2 D2 Bz Fl
3 Al B3 c3 D3 E3 F3

-..and s0 on. In the illustration belaw, for example, cell A contains the
words “Fund-Raising”, and cell C5 contains the number 150.

The INCHES / MILLIMETRES boxes select the units used for measure-
ment throughout the word-processor program, including the dialogs for
sciting the Paper Size, the Margins, and the Tab Ruler.

The DATE FORMAT and TIME FORMAT are used to set the formats
used by the Insert Date and Insert Time commands. Each setting has a
drop-list of the different format options,

16 Mirch B | Gz Bigie
0 Hareh B | elpat & Cider
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The Current Cell

One cell is always highlighted as the “Current Cell”, and its contents are
displayed in the “Contents™ box at the top of the sereen, as well as on the
sprendsheet screen itself. In the illustration, cell B3 is the Current Cell,
and it contains the word "Event”,

Text and Numeric Cells - Formatting

The spreadsheet cells can display two different types of information. Text
Cells contain letters, or a mixture of letters and digits, Text cells cannot be
used in calculations, but are a useful way of adding labels and titles to the
spreadsheet. Numerie Cells contain numbers, or sometimes "Formulae”
which work out numbers by doing calculations on the numbers in other
cells.

The format and style in which a cell's contents appear on the spreadsheel
are controlled by the "Formatting” options. There isa fixed number of
formats, and the formats available for Text and Mumeric cells are com-
pletely separate - vou can only apply a Text format to a cell which contains
Text, and you can only apply a Mumeric format 1o a cell which contains a
number or a formula.

Numeric Cell Formats allow you to control the number of digits shown to
the left or right of the decimal point, and also allow vou to include a
"Currency Symbol™ to indicate that the number réfers to an amount of
money. (The defaull currency symbol is the "£" pound sign, but you can
change it.) Y ou can also define your own numeric formats, (eg changing
the way in which the numbers are aligned, or how negative numbers are
indicated) using the Define Numeric Formats command.

Text Cell Formats are pre-defined, and you cannot change them. You can
simply choose any combination of Bald or Mormal text, and Lefi, Centre or
Rightalignment.

Entering Information in a Spreadsheet Cell

Using the Keyhoard

¥ ou can type text or numeric information into a particular spreadsheet cell
by moving the cursor over that cell using the cursor keys (4~ T4—), then
typing the information you want to enter.
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Using the Mouse and Keyboard

¥ou can type text or numeric information into a particular spreadshect cell
by clicking on that cell, then typing the information you want 1o-enter an
the keyboard.

With the keyboard, use the «T4—» keys to move the current cell cursor,
then press [Ctel][+{1] to enter or edit the cell contents.

Entering Text and Numbers

If you simply type a number, the spreadsheet will assume that this is
numeric data, and will display and Format it according to the “Default
Mumeric Format” setting in the Options menu. Likewise, if vou enter a
picce of text, the spreadsheet will assume that this should be formatted
according to the ' Default Test Format™. In either case, you can apply a
different display format for the information by clicking on the “Format™
drop-list near the top right of the screen,

Using a Formula to Calculate Values

As well as simply displaying columns and rows of numbers and text, a
spreadsheet can also caleulate new numbers using Formulae. A formula
uses cell references (AL, €3 eic, as shown above) to refer to other cells,
and to perform caleulations using the numbers in these cells, For example,
the larmula...

{AT+B3)"A2
-would add together the numbers in cells Al and B3, multiply the result
by the number in cell A2, and display the result of this caleulation, (See
the Formulae section later in this chapter for a list of the spreadsheet’s
formulae, and of the mathematical functions and operators you can use in
them. )
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Whien a cell contains a formula, rather than text or a number, the Contents
box at the top of the screen shows the formula, while the cell in the spread-
sheet jiself displays the result of the caloulation.

Selecting and De-Selecting Cells
Some of the spreadsheet commands can operate on a selected group of
cells, rather than on a single cell. Groups of cells can only be selected if
they are arranged in a rectangular block, as shown here:

Evant Tablogs | Coats | Praie |

[0 [1]
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Tutal Praiil| 11

Naotice that although a group of cells is selected, the current cell (in this
case the one at the top left) is still highlighted separately. There is always
current cell, even when a group of cells is selected - the only exception is
when a whole Row or Column is selected.

If a group of cells has been selected, some commands {such as those used
ta apply cell formats, or Cut/Copy the cell contents to the Scratchpad)
operate on all the cells in the group,

Selecting Cells with the Keyboard

To select a group of cells with the keyboard, hold down the [Shift] key
while moving the cursor over the required group. For example, 1o select
cells B2, B3 and B4, move the cursor to B2, then hold down the [Shift] key
and press [+] twice.

Selecting Cells with the Mouse

To select a group of cells with the mouse, place the mouse pointer at the
top lefi cell in the group, then press and hald down the mouse lefi button,
and move the mouse to the bottom right cell in the group.

De-Selecting Cells
To cancel the selection with either the keyboard or the mouse, simply move
the cursor or click on a cell.
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Spreadsheet Menu Commands

The Spreadsheet Menu
This menu contalns commands for controlling aspects of the whole spread-
sheet, including the commands for Editing, Saving and Printing it.

Start New Spreadsheet
When vou choose to Start a New Spreadsheet, the spreadsheet program
automatically saves the existing spreadsheet. 1t then displays the following
dialog:

You should first choose the location for the new spreadsheet you wanit (o
create, then type a name forit. You can switch between the Cabinet and
Dise by clicking the relevant box, and you can choose a new Folder by
clicking on the E¥ symbol to show the Folders list, then clicking on the
name of the Folder you want.

Spreadsheet Names

Spreadsheet names can normally be up to 32 letters long. 1f press a key
but the character does not appear while typing the spreadsheet name, this
means that the letter you have typed is not allowed in a spreadsheel name.
Characters which cannot be used in spreadsheet names include the ques-
tion-mark (7, the asterisk (*), the slash characters (\ and /), the bar {|), and
the full-stop ().

Onee vou have entered these details for your new Spreadsheet, press /.
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Edit Stored Spreadsheet
This command allows vou recall o stored spreadsheet, so that vou can
make changes (o it or reprint it. When you choose the Edit command, the
program displays a standard Filing dialog, in which you can choose a
location and select a file to Edit.
When vou choose a spreadsheet name from the list, then press f, the
spreadsheet is loaded, and you ean then alter or add to it as you wish,

Save As...
This command allows vou 1o save the current spreadsheet under a different
name, and’or in a different location, thereby creating another copy of it
The command displays the same dialog as that used in the Start New
Spreadsheet command above, and you can type a name and choose a
location in the same way, When you press o, the current spreadsheet is
saved in the new name and location,
Mote also that the old spreadshedt is left intact, stored under its old name.
This means that you can reload and edit the old version of the spreadsheet
even after you have made changes to the new one.

Revert to Saved
This command abandons the current version of your spreadsheet, and
reloads the last version which you saved. It allows you to undo any

changes you have made since the last time you saved your spreadsheet, 1t's

a pood idea 1o save your spreadsheet regularly, using the “Save and Con-
tinue” command in the Tasks menu.

Import Spreadsheet
This command allows you 1o convert a spreadsheet created using an carlier
PCW model or other computer spreadsheet program, and make it into a
PcW 16 spreadshect 5o that you can use it. The spreadsheet data in the file
should ideally be stored in "CSV™ (Comma-Separated Value) format, or in
"DHF" format. However, the spreadsheet program will import any form of
text-based file, on the assumption that commas and Tab characters are
column separators, and that Carriage Returns are row separators.
In order to import a spreadsheet, it must be stored on a disc formatted as
DOS, CPM or Locoscript.. The Import dialog’s "Disc Type" box shows
the format of the disc in the drive, and a list of the files on it

Importing Spreadsheets from PC-Compatibles

If the disc is DOS {ormat, the file containing the spreadsheet data must be
stored in the disc’s “Root” directory, The Impaort dialog displays a list of
all the files in the Root directory - if the filename you want does not appear
in the list, it is not stored in the disc’s Root directory, and cannot be Im-
ported.

Importing Spreadsheets from Locoscript and CP/M Discs

If you created the file using an earlier PCW computer (the PCWE256,
8512, 9256, 9512 or PCW10), the disc containing the spreadsheet will be a
CP/M or Locoscript format dise. Your Pe'W 16 can impont spreadsheets
from a 344" PCW disc, providing that the data is stored in-a CSV or DIF
file,

When Importing from a CP/M or Locoseript dise, you should be aware that
spreadshects can be stored in any of the 16 *Groups™. When you choose
the Import command and insert a8 CPM or Locoscript disc, the Import
dialog shows a list of all the spreadsheets in Group 0 on the dise - if the
spreadsheet you want to Impaort is in a different Group, you can change
Groups using the “Groups” drop-list.

Onee you have selected the correet Group, choose the name of the file you
want to Import from the list of file-names.

Export

When vou first select this command, you are asked to select whether to
export in ASCICSY or DIF format. You must choose one of these export
formats, and when you do, the program displays a dialog showing the
options available for the format you have chosen, You should tailor these
options to suit the program into which you intend to load the exported
spreadshect dam,

For more information about the meaning and effect of specific export
options, Select HELP while the relevant dialog is displayed.

Recalculate Mow

This command forces the spreadsheet 1o recaleulate the numbers displayed
in cells containing formulae, 'With a large spreadsheet, this process may
tuke a few seconds. See Awto-Recalewlare for more information.
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The program will recalculate automatically when printing or saving, and
you can also choose the “Auto-Recalculate” option in the Options menu to
make the spreadshect recalculate every time any new data is entered. 1Mthe
Auto-Recalculate option is selected, you do not need to use the Recalculate
command at all.

Set Print Options
This command controls which parts of the spreadsheet screen are included
in the printout when you use the Print command, There are four different
options, and vou ¢an select any combination of them,
The TITLE is the name of the spreadsheet file. The GRID LINES are the
vertical and horizontal lines separating the rows and columns, and the
COLUMM and ROW LABELS are the letters and numbers showing the

row and column references.

Print Preview '
This command uses the sereen 1o show you a preview of how your printout
will look - checking the preview before vou print the spreadsheet can save
you having to produce test prints. See the Print command below for more
information about spreadsheet printing.

Print Sheet
When vou Print a spreadsheet, o single page is printed in Landscape (wide)
format- use the Print Preview command to see how this will look before
printing.
The printing places the Current Cell at the 1op left of the printout, and
prints as many cells downwards and to the right of the current cell as it can

fit onto the sheet. 17 your spreadsheet is too big to fit on a single sheet, you

can print it onto several sheets by printing one sheet, then moving the
gursor to the first cell which did not fit on the print, and choosing the Print
command again.

Abandon Spreadsheet

This command first asks you if you are sure that you want to Abandon the
current spreadsheet, 17 you confirm, the spreadsheet program terminates,
and any unsaved information in the active spreadsheet is lost.
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The Edit Menu
The Edit menu commands allow you to manipulate the contents of indi-
vidunl cells, or Selected groups of cells.

Cut Selection to Scratchpad
This command empities the current cell {(or all the currently Selected cells if
a group of cells is Selected). The command retains the cell contents on the
Seratchpad, so that you can retrieve them by Pasting: see below.

Copy Selection to Scratchpad
This command copies the contents of the currently selected cells onto the
Scratchpad, but leaves the cells themselves unchanged. You can replicate
the Copied cell conients in a different group of cells using the Paste com-
mand - see below.

Paste from Scratchpad

This command inserts the contents of the Scratchpad into the current cell -
you can plice data on the Scratchpad using the Cut and Copy commands.
I there is nothing stored on the Scratchpad, the Paste command is greyed-
out.

1f you have Cut or Copied a Selected group of cells onto the Scratchpad,
Pasting not only inserts information info the current cell, but also into the
group of cells below and 1o the right of it. The number of cells affected
depends on the number of cells which were selected when the data was
Copied onto the Scratchpad,

Edit Cell Contents
This command is used (o edit the Contents of the current cell - it simply
moves the cursor inta the Contents box above the spreadsheet, and lets you
change or delete the cell contents. While you are éditing the Contents, the
[4—] and [-+] Iu:‘rs maove the texi cursor left and right within the editing
box, while the [ T] and [4] keys move the cursor back into the spreadshect
arca of the screen, and terminate the Edit command.
When you have finished editing the cell contents, you can also press [Re-
turn] to retum to the spreadsheet. Note that you can also switch 1o Edit
maode by elicking with the mouse on the Contents box.
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Delete Cell Contents
This command simply deletes the contents of the current cell, or the cur-
rently Selected group of cells.

Remove Row
This command removes the row containing the cursor. It deletes all the
cells in the row, and their contents,
If you Remove a row by mistake, you can use the UNDO command to
retricve it, as long as you have not used any other commands sinee the row
was Removed,

Remove Column
This command removes the column containing the cursor. All the cells in
the column, and their contents, are deleted.
If you Remove a column by mistake, you can use the UNDO command to
retrieve it, as long as you have not used any other commands since the
column was Removed.

Select Row
This command is a quick way of selecting all the cells in the row which
currently contains the cursor. Cmce the row is selected, you can use other
Edit menu commands to make changes to all the cells in the row,
You can also select a whole row with the mouse, by elicking on the title at
the left end of the row (eg clicking on the "001* title will select the whole of
row 1),

Select Column
This command is a quick way of selecting all the cells in the column which
currently contains the cursor. Once the column is selected, you can use
other Edit menu commands to make changes to all the cells in the column.
You can also select a whole column with the mouse, by clicking on the title
at the top of the column (eg clicking on the "A" title will select the whole of
column A),

Select Whole Spreadsheet
This command is a quick way of selecting all the cells in the spreadsheet.
Omce all the cells are selected, you can use other Edit menu commands to
make changes to them,
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¥ ou can also select the whole spreadsheet with the mouse, by clicking on
the top left comer of the spreadsheet display.

Apply Format
This command lets you choose a new format for the current cell or the
currently selected cells. It displays a list of the formats appropriate for the
cell contents: a list of the text formats if the cell(s) contain text, and a list
of the numerie formats if the cells contain numbers or formulae.
Mote that if vou have selected a group which includes both text and nu-
merfe cells, you can only Apply a format to ane type or the ather - you
cannol apply a Text format to numeric cells, or a Mumeric format to cells
containing text.

Fill Across
This command only operates on a group of cells selected across a single
row. It takes the contents of the lefi-most cell, and copies this data into the
other selected cells.

Fill Down
This command only operates on a group of cells selected down a single
column. Ittakes the contents of the top cell in the group, and copies this
data down into the other selected cells.

Change Column Width
This command allows you to change the width of the column which cur-
rently contains the cursor, Although all the spreadsheet columns have the
same width by default, it can sometimes be useful to make panticular
columns wider or narrower. The command displays this dialog:

In this illustration, the current cell contains the single word "Maoney”, so

this cell is shown in the dialog to indicate the current column width, You
can use the [+] and [-+] keys, or elick on the B and B buttons, to make

the column narrower or wider.
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The Insert Menu

Insert Row
This command adds an extra row to the spreadsheet at the current cell
position. The existing rows below the current cell are all moved down to
make room for the new row. All the cells in the new row are initially
cImpey.

Insert Column
This command adds an extra column to the spreadsheet at the current cell
position. The existing columns to the right of the current cell are all moved
1o the right to make room for the new column. Al the cells in the new
column are initinlly empty.

Insert Date
This command simply inserts today's date into the eurrent cell, as text. The
format of the date can be set using the Set Date/Time Format command in
the Options meni.

Insert Time
This command simply inseris the current time into the current cell, as text.
The format of the time can be set using the Ser Dote/Time Formar com-
mand in the Options menu,

inser Calculation
This command makes the Calculator pop up over the spreadsheet screen.
When you have made the caloulation and you have the result you want
shown on the calculator display, press to exit from the Calculator and
insert the number in the Spreadsheer. Note that calculations are always
Inserted as numeric data,
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The Find Menu

Find Text
This command allows you to search through the whole spreadsheet fora
particular sequence of charncters or numbers. When you select the com-
mand, o dialog asks vou to tvpe the text vou want to find. Type it and
press o to start searching, The search begins at the top left of the sheet,
and works across the rows and then down the columns,
When the program finds your text in a particular cell, it will show the cell
at the top left of the screen, and move the cursor to make it the current cell.
I you want to carry on searching for the next occurrence, simply select
Find again, and press . The new search will begin at the current cell, and
will find the next occurrence.

Go to Cell
This command allows you to move directly to a particular cell, by entering
the cell reference you want to move to. When you enter a cell reference (eg
“A1", or "G25%) and press , the spreadsheet is scrolled so that the chasen
cell is displayed in the top lefi comer of the screen.
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Options

Display Grid-Lines

This command allows you to choose whether or not to display the vertical
and horizontal lines which divide the spreadshect rows and columns.

Auto-Recalculate

When you change or enter numeric data, this may affect the contents of
other cells, because the new cell value may be used in a formula by a
different cell. This command isa toggle: when it is switched on, it ensures
that all the cells are kept properly updated and recaleulated every time you
change a numeric value.

The drawback with auto-recalculation is that it can slow down the opera-
tion of the spreadsheet program - a spreadsheet can contain many formulae,
and recalculating them can sometimes take a few seconds, If you find that *
the spreadshect takes 100 long to récaleulate when you change numeric
values, you can switch ofT the Auto-Recalculate option. However, ifyou
do this, you must make sure that vou force a full recalculation using the
Recalculate New command in the Spreadsheet menu whenever you want o
be sure that the spreadshect is showing the correct values in its numeric
cells,

Mote that even when the Auto-Recalculate option is switched off, the
spreadsheet still recalculates automatically whenever you save or print the
sheet.

Define Numeric Format

This command allows you to change the Numeric Format definitions. It
displays the following dialog:

The dialog has different sections which allow you to define different as-
pects of numerie display. At the top of the dialog is the name of the format
you are redefining - if you want to redefine a different format, you can do
so by elicking on the K symbol to display the list of format names, then
choosing a different format from the list, 1Tyou want (o give the format a
different name, you can type o new name into the box below the old format
name, The other seitings are as follows:

Text Farmat can be Bold or Mormal text, and the Text Alignment can be
left, centre or right-aligned within the cell area. To format numbers in
vertical columns, as is normal for currency display, use the right-align
option,

The Thousands Separator is the chameter used 1o separate groups of
three digits when displaying large numbers. The comma characier is often
used as the thousand separator, but you can also choose to use spaces, or
vou can choose 1o have no separator.

The Number Display options allow you to select whether to use normal or
scientific notation - the Best Fit option uses normal notation for smaller
numbers, but switches to scientific notation if the number becomes too
large 1o it into the cell,
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The Currency Symbol box allows you to include a currency symbol at the

lefi of the numeric cell, and the Negative (nnnn) option shows negalive
numbers in brackets, instead of with & *-" minus sign. Negative numbers
are usually indicated in brackets in financial accounting documents.

Default Mumeric Format
This option allows you to choose which of the Numeric formats acts as the
default. When you type numeric data into a new cell, the display for that
cell is formatied according to the current default, until you Apply a new
format to it
To chooze a new default format, click on the B symbal, then choose a new
default format from the list, and press /.

Default Text Format
This command allows you to select which of the Text Formats is used as
the default when entering text into an empty cell. It works in the same way
as the Default Numeric Farmar command described above.

Set Currency Symbol
“This command leis you choose a new character to indicate currency. The
Currency Symbol is set by default to the "£” character, but you can change
this to “§" for dollars, "¥" for Yen, and 50 on. Note that you can only use
one currency symbol at u time - if you want to display different curren-
cies in a single spreadsheet, you have to enter different currency symbols in
their own cells, as if they were ordinary text.
When selected, the command displays a list of all the characiers available,
and all the accents which you can add to them. To choose a new Currency
Symbol, use the «— T4 keys or click on the character you want. If you
want to add an accent to the character, you can do so by clicking on the
accent you want, or by using [Shift}+{+] and [Shift}+{—].

Set Decimal Character
You can choose from three different decimal point characters: the full-stop
and commia are standard punctuation characters, but the PeW 16 also
provides o "Real® decimal point, which appears halfway up the height, like
this: *2-5". As with the currency symbol, you can only select one decimal
point character at a time.
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sel Date / Time Format
This command allows you to choose how the Date and Time are formatted
when you Insert them using the fnsers Date and fnsert Time commands.
Click on the Bl buttons to see the lists of different formats available, then
choose the format you want from each list.
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Expressions, Functions and Operators

This section details the mathematical components which can be used to build
formulae in the Spreadsheet program,

Mathematical Expressions which act on a Range

The following formulae can be used to build expressions. Each operates on a
range of cells which are given in the form FN{start finish} where start and finish are
valid cell references separated by a colon. For example, AVERAGE(AZDT) and
PRODUCT{AT:AS) are valid formulne.

Reference: Spreadsheet

mathematical Functions
The following functions can be vsed anywhere that a valid expression might
Appear.

Pl returns the ratlo of a circle's diazmeter to its circumference (3.141392654)
=E  returns the base of nptral logarithms (2.713281828)

Mathematical Operators

The following are the mathematical operators that can appear between two
expressions to build larger compound expressions. x and y represent valid
expressions.

SUMirange) sum of ol numesic values in the range
AVERAGE(range) or AVG(rangs) the average of all the values in the mnge. (and ) used to change order of precedence
PROOUCT(range) all the valies in the range are multiplied together L used before a single value it is Egnnud
SUMSOlrangs) the sum of the squares of all the values in the range - used before a single value to change its sign
COUNT{range) the number of the values in the range Ky addition of two values
iy subiraction of two values
Mathematical Expressions which act on a Single Argument 1"y multiplication of two values
The following formulae can be used in expressions. All take a single argument, Wy division of two values
%, which can be any valid expression itself. Y the first value, x, to the power of the second value y
{ xMODy the integer remainder of division of the first value by the second
SIN{x), COS(x), TAN(x) trigonometric functions with argument in degrees sDivy the integer division of the first value by the second
SANR(x), COSR(x), TANR(x) trigonometric functions with argument in radians 1%y gives y percent of X
DEG{x) the argument converted from radians to degrees LMAXY returns the maximum of the two values
RAD{x}) the argument convened from degrees 1o radians LMy returns the minimum of the two values
ASIN(x), ACOS(x), ATAN) the inverse trig function of the argument in degrees KNCRY returns the number of y combinations from x
ASINR(x) ACOSH{x) ATANR(x)  the inverse trig function of the argument in radians xNFRy retumns the number of ¥ permutations from x.
SINHIx), COSH{x), TANHx) hyperbolic trigonemetric functions
ASINH(x), ACOSH{x), ATANH[X)  inverse hyperbolic trigonometric functions
RECP{x) the reciprocal of the argument
SOR(x) the square of the argument
SORT(x) the square root of the argument
LOG{x) the base 10 logarithm of the arpument
LM[x) the base e (natural) logarithm of the argument
EXP(x) base ¢ antilogarithm of the argument (ie e™x)
ABS{x) ahsolute value of argument
FLODR(x) previous integer before argument
CEILING(x) next integer after argument
INT{x) nearest integer o argument
FACT(x) gives x! - factorial of the argument
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The Address Book

The Address Book allows you to store a list of names, addresses and other
information in a kind of database, This section explains each Address
Book menu command in detail - see the Beginner's chapter for a simple
guide to the Address Book screen and how to use it

The Book Menu
This menu contains commands which affect the whole Address Book, and
the sereon display.

Alphabetic List of ...
¥ ou can use this command to choose the order in which your Address Book
eniries are listed on the screen, Because the Address Book has several
pieces of information, or "Fields”, in each Entry, vou can change the way in
which the list of Entries is crdered.

By default, the list will be arranged in alphabetical order, based on the
conienis of the "Mame| ® field in cach entry. You can also choose to base
the alphabetical listing on the contents ol the "Name2", "Post-Code” or
“Motes” fields, Choose the sort option you want by clicking one of the
boxes, then press . You should see that your Address Book is now listed
in the arder yon chose.

When sorting alphabetically, numbers are listed before letters. Entries
which contain no information in the chosen field will appear at the end of
the list,

Import
¥ ou can use this command 1o add information from an address book which
you have created on another computer into your PeW 16, to save time
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retyping the names and addresses. For example, il you have an Amstrad
NC200 notepad computer, you can use this command to transfier your
existing NC200 address book into your PeW 16, You can also Impaort d
from a "CSV" or "Comma-Separated Value® file - this can be created usi
a PC-compatible or other type ol computer, and can contain names and
addresses in a similar structure to the PeW 16's Address Book.

When you select the Import command, you first have to choose whether
you are Importing from a CSV-format file, or from an Amstrad NC200
Address Book:

Click the box for the option you want, insert the disc containing the
book file in the drive, then press /. I you arc importing a CSV file, the
program displays a dialog listing all the files on the dise (see below).
Select a file to import from the list, then press /.

Motes on Importing CSV files

Ifthe file you want is not in the list, it is not stored in the DOS "Roat”
directory of the dise. CSV files can only be Imported from a disc's root
directory, not from sub-directories. When using a different computer to
create a CSV file for importing into the PeW 16 spreadsheet, ensure that the
file is stored in the Root directory,

When you are Importing a CSV file, the address data cannot be guaran
to fit properly into the PeW 16's Address Book unless you have made sure
that the program which created the file used the correct format. There are
many variations of CSV file, 50 to ensure that CSY data is imported
correctly, the source program must be configured to store the "fields”
(Namel, Name2 etc) in the same order as that used on the PeW16's Ad-
dress Book sereen, and to inelude blank fields where there is no equivalent
field in the source data, s
As a precaution, belore importing a file, we recommend that you make a
copy of the Cabinet on a floppy dise, using the Backup Cabinet to Disc

command in the File Manager. Ifthe file you import causes a problem, and
you want to revert back to your original address book, vou can then Re-
store the Cabinet from the dise in the File Manager.

Export
¥ ou can use this command to save a copy of vour Address Book onto a
floppy disk. The address book is stored as a CSV file, so that it can be
Imported into the Address Book on another PeW 16, or used by other
programs on other types of computer. The Address Book file is stored in
CSY formal.
When Exporting, insert the dise before selecting the command. When you
then select Export. the program displays this dialog:

Type a name fior your Address Book file, then click .

Mote that the filename you type must be compatible with DOS - see appen-
dix F, on DOS compatibility, for more information. 17 you do not add a
suffix to the file name, the suffix *.CSY™ will be added sutomatically,
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The Entry Menu
The commanids in this meny deal with individual Address Book Entries.

Add Mew Entry
This command is also activated by pressing the BLUE key. You must use
it every time you want (o add a new entry to the book.
When vou select the command, you will see that the "Entry” panel on the
left of the sereen goes blank, and the cursor flashes in the "Namel" field,
Type the sumame for the new Entry, then press [Retum] 1o move down 1o
the "Mame2" field, Continue typing and pressing | Return] until you have
entered all the information you want to include in the Entry.
The new eniry is displayed in the list on the right of the screen as soon as
you select another command, or when you press [Return] when the cursor
is in the "Motes" field at the bottom of the Entry,

Go To Initial Letter !
This command ennbles you o move quickly to any initial letter in the
Address Book list. The command displays this dialog:

For example, if you want to find the first entry in your book with the
NAME! field beginning with 8, select o To Mnitial Letter and type 5, 1
click OK or press /.
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pelete Entry
This command is also activated by pressing the RED key. 1t deletes the
entry which is currently displayed in the "Entry” panel.
To delete an entry, first choose which entry you want to delete from the list,
using the T& keys or by elicking with the mouse, then click the Delete
button or press the RED key.

This dialog asks you to confirm that you want to delete the entry - when
you press /), the entry is deleted from the Address Book

UNDO

If you delete an entry by mistake, vou can usually retrieve it by pressing
UNDO.

Find Entry
This command is also activated by pressing the YELLOW key. You can
use it to search through the Address Book for a particular name, address,
number, or any other piece of texi which appears somewhere in the entry.
When you choose the Find command, the program displays this dialog:

Type in the text vou want to search for, then press /. The program will
search through all the fields in all the entries - when it finds the text you
have entered, it will display the entry containing that text in the “Entry”
panel. The program searches all the fields, so the text ean be found any
part of the entry; name, address, phone number, notes ete.
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The Diary / Alarm

The Diary Screen
The Diary sereen has two main panels: the Calendar panel and the Ap-
pointments panel.

[Taaks

) it

i\

e gEsE TR s

The Calendar Panel
This operates just like a normal calendar, except that it can show the days
of the week for any year you choose, You can move the calendar display
forwards or hackwards by a month or by a vear, using the B and B buttons
at the bottom of the calendar, When you choase different day in the calen-
dar, that day's appainiments are shown in the Appointments panel.
Below the Calendar is a Clock, showing today’s date and the current time,
This shows the real time, as set by the PeW 16's internal clock.

The Appointments Panel
This acts rather like a diary page. By defanlt it shows a whole week, but it
can be changed to show just ane day - this is useful if you want to enter
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The Appointment Alarm
The program has an Alarm facility - you can enler a time for your appoint-
ment, and when that time is reached, your PeW 16 will display the appoint-
ment on the screen, and (azh the " Appointments” light at the top right of
the keyboard, You can also choose the "Audible Alarm® option, so that the
PecW 16 makes a beeping noise to attract your attention at the appointment
time.
Mote that the appoiniment alarm will sound, and display the message you
typed in for your appointment, even il you are using a different program
(say the Word-Processor) at the appointment time. The alarm will even
operate when the PeW 16 is in "Standby" mode, switching the computer on
and displaying the message for five minutes before switching ofT again.

several appoiniments for a single day, because it provides more space for
showing each day's appointments, and their messages. For example, if the
Appaintments panel shown in the illustration on the previous page were

switched to Single Day mode, it might ook like this:

D et B
Each Appointment appears as a line ol text. 17t is a timed appointment
(see Add Appoiniment below), its time is displayed beside it, and if it has
the Alnrm option selected, it also displnys a small "4&" bell symbol, like
"08;00 Wake Lip" appointment shown above,

This allows vou to see all the appointments and alarms for a particular
at i glance.

Using the Diary
¥ou can use the Diary / Alarm like an ordinary paper diary - it has a page
for each day (or it can display a whole week on a single page), and you
write up to 16 "Appointments” into each day. The program's Calendar
display shades all the days which have appointments in them, and you can
use the calendar to move quickly from month to month and year to year,
Y ou can also move forwards and backwards through the diary by ¢licking
the B3 and B3 buttons at the bottom of the Appointments panel. This mov
you forwards or backwards by one week or one day, according to wheth
the Appointments panel is working in Week or Day mode.
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The Date Menu
Thie commands in the Date menu moves the Appoiniments page to display
different days.

Show Today
This command switches the Appaintments display to show "Today”,

Go to Date...
This command allows you to enter a date, either by typing a new date or
using the “Spinner” butlons to move the date forward or back. When you
press ', the Appointments display moves to the date you have chosen,

Show Next Appt
This command searches forward from the current appointment or day unti
it finds the next appointment. 1t then moves the Appoiniments display so
that it highlights the next appointment.

Day + and Day -
These commands move the Appointments display forward or backward by
one day. You canalso use the [T] and [4] keys to do this,

Week + and Week -
These commands move the Appointments display forward or backward by
one week. Ifthe Appointments display is se1 to "Week" view, you can also
use the [+—] and [—#] to do this.

Month + and Month -
These commuands move the Appointments display forward or backward by
one month. You can also use [Shift]+[<] and [Shift]+[—] to do this,

Year + and Year -
These commuands move the Appointments display forward or backward by

ane year. You can also use [Cerl]+[Shift]+[+ ] and [Crrl]#[Shift]+[—»] 10

dothis
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The View Menu

show Day and Show Week
These commands select whether the Appointments display shows a single
day, ora whole week. The Show Day command makes the Appointments
display show anly a single day, while the Show Week command switches it
o show T days.

Amstrad PCWI4 Page 127



Reference: Diary / Alarm

The Appointments Menu
These commands are used (o add, change or delete appointments;

Add New Appointment

When you select this command, the program displays a sequence of dia-

logs, into which you can enter details of the appointment you want to m

There are five pieces of information you can enter for cach appointment,

and each displays a separate dislog. At any point in this sequence, you
click the FINISHEDY button to aceept all the appointment settings, or
can click the MOREg button to move to the next dialog. The five dia
e

The Appointment Message

Thils is the text which is shown on the Appointments display, though if

appointment text is quite long, you may only be able to see the first few ]

words. If you choose the Alarm aption (see below), the Appoiniment
Message is also displayed on the screen when the alarm time is reached.
Appointments Without Times

MNote that if you simply want 1o make a note shout the day in general, you

can just type the appointment message and press FINISHEDY to create an

appointment which does not have a time or alarm, Appointments with no

time details appear at the top of the display for cach day, before the carlics

timed appointment.

The Appointment Time

This time is shown beside the Appointment Message. 1f you choose the
Alarm option (see below), this is the time ot which the alarm will go off.
The Appointment Date

By default this will show the currently selected day in the Calendar, but
you can change it by typing a new date, or using the spinner buttons to
move the date forwards or back.

The Repeal Options

You can make a single appointment appear at regular intervals, at the sam

time every day, every week, every month or every year.

The Alarm Oplions

You can choose whether or not the PeW 16 displays an alarm at the ap-
pointment time. Mote that you need to use the Options command (see

Reference: Diary / Alarm

below) 1o choose whether the audible alanm will sound, and whether the
PeW 16 will "wake up” from Standby mode to display the alarm. See
Cptions below.

edit Appointment
Whenever the Appointments display shows any appointments, one of them
will always be highlighted. You can use the Edit Appaintments command
1o alter the details of this appointment. To highlight a differcnt appoini-
ment an the same day, use the [ 1] and [+] keys,
The Edit command lets you change any or all of the details you entered
when you first Added the appointment, and it displays exactly the same
dinlog sequence as the Add command detailed above. Ateach dialog, if
you just press [Return], the old details will be retained,

Delete Appointment
This command simply deletes the currently highlighted appointment. Note
that if you delete an sppointment by mistake, you can use the UNDO key
{or click on UNDO in the menu bar) to retrieve it, as lang as you have not
used any other commands in the meantime.

Options
The Options command displays the following dialog:

W

The Alarm Options boxes allow you to control what happens when an
alarm goes off. If the PcW 16 is switched on, it will always display the
appointment message, and will not let you continue until you to press the
key to confirm that you have seen the message. There are two other alarm

options:
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The Sound Beeper option makes the PeW 16 sound an andible alarm at
appainted time,

The Wake up from Standby option only operates if the computeris in
Standby mode when the appointment time is reached. 1fthe option is
selected, the PeW 16 will switch itself on automatically, display the alarm
(and sound the beeper if selected), and wait for you to acknowledge the
alarm.

Ifthe alarm is not acknowledged afier 5§ minutes, the PeW 16 switches ilse
back into Standby mode.

Reference: File Manager

The File Manager

Why Do | Need a File Manager?

Your PeW 16 only contains a limited amount of storage space - afler you
have been using it for a while, the "Cabinet” is likely 1o become full, and
you will need 1o clear some files out onto floppy disc. 1t's also a good idea
to make "backup” copies of your documents and files, in case anything
goes wrong with the Cabinet storage inside the PcW 16,

The File Manager program allows you to see the files stored in the Cabinet
and on dise, and to copy, move and delete them. There is a special
"Archive" command, which automatically selects the oldest files in the
Cabinet and moves them onto a floppy dise. The File Manager also in-
cludes Backup and Restore commands, for making a backup copy of the
entire Cabinet, including the Address Book.

The File Manager Screen
When you first select the File Manager program from the desktop, the
sereen looks something like this:
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At the top of the screen, below the menu bar, are three large buttons - thes
are used for fast access to the Copy, Archive and Delete commanids,

is also a Stop button, which is used 1o guit from the File Manager and
return 1o the Deskiop. Below, there is a panel showing the contents of the.
Cabinet.

On the left of this panel. there is a list of all the Folders in the Cahinet.
One Folder is selected - in this case, "Folder01", The files in the selected
folder are listed on the right.

File Type Indicator

As well as the name of the file, the list also shows the time and date at
which the file was last saved, and the file size. Just to the left of the file
name, there is a small symbol, usually [ or [ - this indicates which pro-
gram was used to create the files. [Blindicates that the file is n Word-
Processor document, while B indicates a Spreadsheet file. Other symbols.
are used for other types of file, but these are stored in the System folder,
and you will not normally see them.

File Size Indicator

The size of s computer file is measured in Bytes, so a file which has, say,
size of "250" 15 250 bytes long. Because files can contain many thousands
of bytes, larper sizes are measured in "K", or Kilo-Byies. Each Kilo-Byie
is 1024 bytes. When the File Manager program reports the size of a file
"10K", this means that the file is (approximately) 10x1,024 or 10,240
bytes in size,

Reference: File Manager

Using the Floppy Disc
The File Manager screen can also be split, so that you can see the contents
of the floppy disc as well as the Cabinet. To see the contents of a floppy
dise, put the disc in the drive, and press [Ctrl]+{L], or click the mouse right
button. The computer scans the dise to find out what files it contains, then
displays the disc and Cabinet contents like this:

i ".I-'I'II'I ‘l""_ﬂ'-_u':l.'ﬂ:l."r 'l-‘
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In this illustration, the disc's Folderd ] contaims the same files as the
Cabinet's Folderll, Twao of the files on the disc are also "Selected” - see
below for more information about Selecting files.
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The File Menu

Selecting Files...

The commands in this menu are used to manipulate individual files, or
groups of files,

Commands such as those used for Copying, Moving and Deleting files
operate on files which are "Selected” before the command is used. Files
which are "Selected” are shown as white-on-black in the file list. You
cannot select Cabinet and Disc files at the same time, and you cannot se
files which are not visible on the screen,

with the Mouse

You can select a file by clicking on it with the mouse - click again and the
selection is cancelled. To change Folder, click on the name of the Folder
you want.

«.with the Keyboard ;

If the screen is split to display both the Cabinet and the Floppy Disc, use
the [Tab] key to switch between them.

In the Cabinet and Disc panels, the [1] and [4] keys are used to select
the Folder and the Files - first use T4 to move the selection up and down
the list of Folders, until the Folder you want is highlighted. Then, press th
[-+] key - the IT‘] and [4] keys now move through the list of files. Move
the box over the filename you want to select, then press [Space] to select
the file. Pressing [Space] again de-selects the file,

Using the File Commands

Once you have selected the file{s) you want, choose what you want to do
with these files by selecting a command from the “File® menu. IT you wan
to Copy or Delete the files you have selected, you can click the Copy
button (press Blue) or the Delete button (press Red) instead of chooting
these commands via the File meny. Sec below for a more detailed descrip-
tion of how to use these commands.

Reference: File Manager

Copy File(s)
This command copies the currently selected files to a different location,
You can copy files between the disc and the Cabinet, and you can choose
which Folder to copy into, The command displays the following dialog:

You must first choose whether 1o copy the selected files to the dise or the
Cabinet - do this by clicking on the Cabinet or Dise boxes, or by pressing
[Tahb] repeatedly until the box you want is highlighted, then pressing
[Space].

Mext, you mist choose a Folder in the location you have selected. One of
the Folder names is shown, bul you can change this by clicking on the
symbol and choosing a new Folder from the list. Press o to confirm your
selection and begin copying.

Move File(s)
This command works in exactly the same way as the Copy command
above, and uses the same dialog. The only difference is that instead of
making copies of the selected files in the new location, it moves the files
from the old location to the new one.
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Rename File
This command lets you change the name of a file. When you select it, it
displays a dialog showing the name of the selected file:

Simply type a new name for the file, and press  to confirm.

1fyou had selected more than one file when you chose the Rename com-
mand, the program automatically displays the Rename dialog again, this
time with the name of the second file in it. When you type a new name for
the second file, the program automatically shows you the third file, and so
on until all the files you selected have been renamed.

Delete File(s)
This command allows you to delete the selected files, When you selecta
group of files and choose Delete, you will see this dialog: f

Toue THIE 1937 7104795 13

To make sure that you don't delete files by accident, this dialog lists the
files you have selected, and asks you to confirm that you definitely want
delete them. To delete all the files in the list, click the SELECT ALL

button (or press [A]), then the DELETE SELECTED FILE(S) button (or
press [D]),

Alternatively, you can select files individually by selecting them (using T4
and [Space]), and Delete the files as required.

When vou have deleted all the files you do not want, press o/ to finish.

select All and De-Select All

These commands are simply shor-cuts 1o selecting or de-selecting all the
files in the currently active Folder,

Change Default File Storage

When you create i new document or spreadsheet, the program automati-
cally sugzests a location for the file (though you can always change this
location at the time you create the file). By default, this location is
FOLDERD in the Cabinet, but you can use the Change Default File
Storage command to alter the automatic suggestion to a location of your
chaice. Using this command has no obvious effect: you will not see the
new default location until you next use the word-processor or spreadsheet
Progrim.
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show Disc Folders
This command splits the screen, and shows the contents of the Floppy Disc
folders in the bottom panel. The command isa "Toggle” - if the "Disc”
panel is already visible, selecting the command again will remove it
You can also display the disc contents by pressing [Cirl}+[L], or by click-
ing with the mouse right button,

Show Disc System Folder
This command can be used to show the contents of the System Folder on
the floppy dise. All the discs you format on your PcW 16 have a System
Folder, but it is not normally used for storing files, unless the disc is used
to make o Backup of the entire Cabinet. See Backup below.

The View Menu
The View Menu commands affect the File Manager's screen display only -
they do not alter the content of the Cabinet or the Disc in any way.

List Order
In the Cabinet and Disc panels, the files in each Folder are shown in a list.
This list can be ordered in three differont ways, and this command is used
to change the list order,

The files can be listed by name Alphabetically, or by Size (largest first),
by Date (most recent first).

Show Cabinet System Folder

As well as the sixteen normal Folders which always appear in the File

Manager panels, the Cabinet also has a special folder called the System
Folder. This is used for storing files which are used by the computer’s

operating system and programs - such files include the information in the
Address Book, the Templates and Fonts used by the Word-Processor, and
the Configuration information you enter when you first use the computer.
¥ou can use this command to include the System Folder in the File Manag-
er's Cahinet display, so that vou can see the files stored init. However, it
very important to understand that the files in the System Folder are essen-

tial for the proper operation of your PeW 16 - if you delete or change any o
them, your system may not work properly. DO NOT MAKE ANY
CHANGES TO THE FILES IN THE SYSTEM FOLDER UNLESS
YOU KNOW EXACTLY WHAT YOU ARE DOING,
This command is a "Togele®. If the System Folder is hidden, the command
will display it. If it is already displayed, selecting the command again will
hide it.
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The Cabinet Menu

Folder Names

Archive

The commands in this menu apply specifically to the Cabinet and its
contents,

This command allows you to change the names of the Cabinet Folders -
default names are FOLDEROI, FOLDERDZ etc, but it s sometimes
to change these names, especially if you use a particular folder fora
particular type of file. For example, if you use the word-processor to write
letters and invoices, you might want to keep these in separate folders, and
to call the folders "LETTERS" and "INVOICES", The Folder Mames
command displays the following dialog:

The dialog contains a drop-list of the current folder names, and a box for
typing the new name. Click on the B symbaol to display the list (or press
[Tab] repeatedly until the E¥ symbaol is highlighted, then press [Space]),
then choose a folder name to change from the list, Next, type the new
name for the folder, and press ' to confirm.

IMPORTANT NOTE: Folder names cannot be more than eight characters:
long, and can only include the letters A-Z and numbers 0-9, They cannot
contain spaces, punctuation characters, or accented characters.

This command provides an automatic method for clearing out the oldest
files from your Cabinet folders, and moving them onto a Noppy disc w
make more space available in the Cabinet.

When you select the Archive command, it analyses the Cabinet to see how
much free space there is, and if archiving is necessary, the program works:
out how many files need to be removed. If you choose the command while
there is still plenty of space left in the Cabinet, the program will inform vol

Reference: File Manager

that Archiving is not necessary, 1T Archiving is necessary, the program will
ask you to insert a disc, and tell you the dote of the newest files which will
be removed from the Cabinel.

Mote that because Archive is infended to be a simple and automatic proc-
ess, the command does not allow you to select individual files for archiv-
ing. If you want o select "hy hand” which files to archive, use the Move
command instead,

Backup Cabinet to Disc
This command makes a complete duplicate copy of the contents of the
Cabinet on a floppy disc. In doing so, it erases any data which was previ-
ously stored on the dise, 5o vou must never backup onto a dise which
contains files you want to keep,
Backing up is an important process for computer users, and we recommend
that you take a complete backop of your system at regular intervals. You
can rewse the same dises for backups as many times as you like, but we
recommend that vou keep three generations of backups - in other words,
reserve three different Moppy discs exclusively for backing up, and every
time you do a new backup, use the disc containing the oldest backup, 5o
that the old backup is over-written. This means that even if something goes

wrong during the backup process, you still live two full backups of the
Cahinet contents.

Restore Cabinet From Disc
This command is used to Restore the contents of the Cabinet from o
Backup dise, Note that when you Restore, all information stored in the
Cabinet is over-written, and cannot be recovered. Only use the Restore
command if you have experienced a "Fatal Error”, and had to restart your
PeW 16 using the Rescoe Disc.
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The Disc Menu
The commands in this menu apply specifically to the Floppy Disc and its|
conlenis.

Folder Names
This command allows you to change the names of the Folders on your
Floppy Dise. It operates in exactly the same way as the Folder Names
command in the Cabinet menu - see previous page for details.

Format Disc
This command formats or re-formats a floppy disc. ]
Floppy discs must be formatted before they can be used for storing files, |
you buy a box of new discs, you will find that you cannot use them with
your PeW 16 (even if they appear 1o be "Pre-Formatted”) until you have
used the Format command to create the PoW 16's Folder system on the di
For mare technical information about disc formats, see appendix F.

Duplicate Disc
This command makes a copy of one floppy dise on another floppy disc,
copies the entire disc, including all the folders and files. Note that any file
already stored on the destination disc (the one you are copying onto) will
destroyved in this process.
The Duplicate command does not affect the Cabinet in any way.

Change Disc
You should use this command to tell the File Manager program if you
change the disc in the floppy drive, It forces the program to scan the new
disc, and update the Folder and file lists in the Disc panel,

You can also click the mouse right button to force the program to scan the
floppy disc.
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Appendix A:
Safety and Cleaning Instructions

Health Concerns - EC Directive 90/270/EEC
There are certain minimum health and safety requirements which relate to
working with computers. These requirements are set by the Display Screen
Equipment EC Directive 902 T0/EEC and employers must comply with
them. The following information is extracted from the Health and Safety
Executive’s “Guidance on Regulations 902 70WVEEC™.
Upper Limb Pain and Discomfort
Conditions of arm, hand and shoulders linked to display screen work, range
from temporary fatigue and soreness to occupational cramp and to chronie
soft tissue disorders such as inflamed tendons or carpal tunnel syndrome.
AVOID prolonged static posture, awkward positioning of the hands and
wrists and high workloads and tight deadlines.
USE proper equipment and furniture, Always follow correct training.
Design job and workload to incorporate other tasks or breaks away from
the display screen. Consultyour doctor if you experience soreness, pain or
discomfort.
Eye and Eyesight Effects
Users may experience lemporary visual fatigue such as impaired visual

red or sore eyes, headaches, or the adoption of swkoward

posture which can lead to upper limb disorders.
AVOID poor positioning of equipment, poor legibility of screen or source
documents, poor lighting including glare and reflections, drifting, Nickering
of jittering screen.
Take appropriate eye and sight tests regularly, Clean the screen and
inspect equipment for maintenance regularly. Report any equipment
malfunction immediately.
Fatigue and Stress
Many symptoms described by display screen workers reflect stresses
arising from their task.
Stresses can arise from poor job design or work organisation. Lack of
sufficient control of the work by the user. Under utilisation of skills. High
speed repetitive working or socinl isolation.
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Safety instructions

Avoid stress by ensuring good design of workplace, environment and task
Equipment should be carefully selected and positioned, Train, consult and
involve the user.

Your PeW 16's clock is powered by an intermal NiCad battery which needs:
to be charged, The first time you switch on leave the PcW 16 connected 1o,
and switched on at the mains power supply for 2 hours (the Standby butt
on the front can be switched off) this will charge the NiCad. Youcanbe
using the PeW 16 while charging is taking place. You may need to repeat.
this procedure if the PcW | 6 has been disconnected from the mains fora
prolonged period.
ALWAYS switch off using the STANDBY BUTTON on the front of your
PcW16, or the "Switch Off" command in the Tasks menu. NEVER swif
off by disconnecting from the power supply - you may lose the work you
have done. Only disconnect the power when the Standby button glows
not while it is flashing.

Safety
When choosing a position for the computer make sure that all the equip-
ment is installed close to, and within easy access of, the electrical mains
supply socket.
Make sure that the equipment is not situnted near an artificial heat source,
such as a radiator, near a water supply, in dircet sunlight, nor in a humid or
damp atmosphere. These elements can damage your computer and destroy.
data. Avoid a location where the computer will be exposed to dust, dir,
vibration, excessively high or low temperatures or rapid changes in tem-
perature. The operating temperature specification for this computer is
between 10°-35°C,

When not in use your PeW 16 should be switched off at the mains power
supply. However, if you want the alarm 1o operate in "Wake-Up” mode,
you must leave the PeW 16 in Standby mode.

Appendices

Sensible Safety Precautions.
Switch off the computer completely and disconnect the power plug (by
pulling the plug, not the cord) if any of the following conditions exists:
» the power cord or plug becomes fraved or olherwise damaged
* vou spill something into the case
= your computer is exposed to min or any other excess moisture
+ your computer his been dropped of the case has been otherwise damaged
= you suspect that your computer needs service or repair
* you want 1o ¢lean the case

Cleaning your PcW16
When cleaning your PeW 1 6, please observe the following points:
= Switch off the computer completely and disconnect the plug (pull the
plug not the cord ).
= Don't use aerosol sprays, salvents, or abrasives,
* Do not get moisture in any of the openings,
= Use a soft, lint-free cloth dampened with water for the cabinet,
= Use houschold glass cleaner on a soft cloth to wipe the screen.
» Do not spray any liquid directly onto the cabinet or screen.

Cleaning the Mouse
If the mouse movement becomes jerky, this may be due o dirt accumulat-
ing on the moving parts inside the mouse. To clean these, you must remove
the rolling ball as follows.
First, turn the mouse over and twist the collar around the ball anti-clock-
wise. Tum the mouse over again so that the ball falls oul. You can now
clean the ball with a soft cloth. Inside the cavity where the ball is normally
located, you should be able to see two black plastic rollers. You should
remove any dirt or debris from the surface of these rollers.
When you have cleancd the mouse's moving parts, drop the ball back into
the hole, and replace the collar.
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Appendix B:
Replacing your PcW16's Mains Plug

Fuse

The Mains lead supplied with this equipment is fitted with a standard 13
amp plug (BS 1363) and is fined with a'5 amp fuse. When changing or
examining the fuse, the correct 5 amp fuse - ASTA or BSI approved (BS
1362) must be fitted and the fuse cover replaced. 1T the fuse cover is lost,
the plug MUST NOT be used until the correct replacement fuse cover is
obtained from the manufacturer (see the beginning of this manual for
details of how to contact Amstrad Direct).

Plug Type
‘The 13 amp plug is the most widely used type in the UK and should be
suitable for most users. However, some locations (mainly older buildings)
may not be equipped with normal 13 amp sockets. In such cases it is
recemmended that a suitable plug adapter be purchased from your dealer
(rather than remove the moulded plug). However, should you decide 1o
change the plug. please follow the instructions below.,

Wiring
The wires in this mains lead are coloured in accordance with the following:
code:

+  Green-and-Yellow - Earth

* Bhe - Meutral

= Brown: - Live -
As the wires in the mains lead of this apparatus may not cormespond with
the coloured markings identifying the terminals in your plug. please pro-
ceed as follows:
The wire that is coloured green-and-yellow must be connected to the
terminal which is marked by the letter “E" or by the safety earth symbol...

L

-..or coloured green or green and yellow.
The wire thut is coloured Blue must be connected to the terminal which is
marked by the letter “N" or coloured black,

The wire that is coloured Brown must be connected to the terminal which is
marked by the letter “L"™ or coloured red.

A5 amp fuse must be fitted either in the plug or adapter or st the distribu-
tion board.

WARNING
THE PeW 16 UNIT CONTAINS LIVE PARTS INSIDE - DO NOT
REMOVE ANY SCREWS. THE UNIT MUST BE EARTHED,
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Printer Types
There are three basic printer types which you ean use with your PeW16,
though not all printers of each type will necessarily be compatible. The
three types are:

Appendix C:
Printers and Compatibility

Essential Printer Jargon

You can use a range of different printers with your PeW 16, The very first
time you first switch the unit on, it will ask you which type of printer you
are ustng, and will then configure ftself correctly for the printer you choose,
Note that if the name of your printer is included in the printers list, you
should always select it - do not choose a “compatible” option unless
your printer does not itsell appear in the list.

1T you wanl to use a printer which is not ineluded in the list of printers
specifically supported by the PeW 16, you may need some help choosing
the correct option,

MNote that all printing from the PeW 16 is in "Graphics Mode™, even when
you are printing texi from the word-processor, so your printer must be
capable of printing graphics. This means that a Daisy-Wheel printer
cannot be used with the PeW 16,

To use this section, you will need 1o understand a couple of special techni-
cal terms about printers.
The first is the printer's Reselution, usually a measure of its print quality.

A printer's resolution is the number of dots it can print in a given area, and

it is normally measured in Dots Per Inch, or "DPI™. The higher the DPI,
the more detail you get in the printout. The PeW 16 can print at two
different resolutions: 300dpi and 360dpi.

The second term is Emudation. Instead of making every priniter unique,
manufacturers usually make each new model emndate, or behave identically
to, an earlier one. This means that if you cannot select your own particular
printer by name, you can instead select a printer which it emulates, For
example, most laser printers emulate the HP-Laserjet, so if you have a

laser printer which is not specifically supported by the PeW 16, you may be
able 1o make it work by selecting the HP-Laserjet printer option. Each type
of printer listed below includes a deseription of the commonly emulated
printers in each category.- Printers which emulate other printers are also
described as comparible with them.
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Laser printers - such as the HP-Laserjet series;
Inkjet printers - such as the Canon Bubblejet or HP-Deskjet series;
Dot-Matrix printers - such as the Epson LQ) series (and many others),

Laser Printers

To operate with your PeW 16, a Laser printer (or LED printer) must be
capable of 300dpi resolution, and be compatible with the HP-Laserjet
standard to PCL level 5. You do not need to know what this "PCL" J
number means, but you should be able 1o check with your printer supplier,
or in your printer manual, that your printer fulfils this specification.

Nate that you cannot use a Postseript laser printer, or Windows GDI
printer, with your PeW16. Some laser printers allow selection of Post-
script or GDI and HP-Laserjet (or "PCL") - if your printer is capable of
both modes, make sure that it is set to Laserjet mode, not to Postscript or
GDI mode. I

If you are using an OKI LED printer, vou should always select the appro-
priate OKI printer type, not the Laserjet PCL option.

Inkjet Printers

Inkjet printers can operate at either 360dpi (the Canon Bubblejet and
wir‘lndpm:‘bln. and the Epson Stylus printers), or 300dpi (the HP Deskjet and
compatibles),

Canon Bubblejet

Apart from the Canon BJ-30 (which you can select specifically), most
Bubblejets can operate in two different emulation modes, called

*Epson LQ" and "Canon BJ" emulation, See your printer manual for
details of how to set the printer mode.

Y¥ou can use any of the Canon Bubblejet series printers with your PeW 16.
The BJ-30 has its own specific option in the selection list, but for the other
Bubblejets, select the "Canon Bubblejet” type, using the "BI" or "LQ"
option depending on your printer’s emulation setting. Note that you will
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normally achieve the best print quality from a Canon Bubblejet if you
operate the printer in BJ mode.

Epson Stylus

If you have an Epson Stylus printer, or one which is compatible it, you
should select the *Epson Esc/P2" option in the list of printers.
Hewlett-Packard Deskjet

The HP-Deskjet range of inkjet printers operate at 300dpi. The PeW16
only supports HP Deskjet series with model numbers above 500, and does
not support the Deskjet 500C model. Ifyou have a Deskjet 500 or higher,
choose the option for "HP Deskjet and compatibles™ in the list of printers.

Dot-Matrix Printers

The PeW 16 supports two general types of dot-matrix printer: the

"Epson LO™ type, and the “[BM X24E" type. Note that these are both
24-pin printer types: the PeW16 does not support any 9-pin dot-matrix
prinfers.

Most 24-pin printers will emulate ane or both of LO or X24E systems, but
you must make sure that the printer is switched (o the same emulation as
the one you select in the PeW | 6's Printers list. For example, a printer
which supports bath LO and X24E modes will not work if you set the
printer to L0 mode, but select the *X24E and compatibles” entry in the
PeW 6% Printers list.

A few early 24-pin printers will not wark properly with the L.O or X24E
option, Ifyou find that you cannot print using either of these emulations,
try selecting the "LO1500" printer option.

For details of how 1o set your printer's emulation, please see your printer
manual.
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Appendix D: Dialogs and the Keyboard

IF you wani to avoid using the PeW 16's mouse altogether, you can operate
all of the Menus, Commands and Dialogs using only the keyboard. In-
structions for operating the Menus and Commands using the keyboard are
given in section B of the Beginners Guide chapter.

Dinlogs are more difficuli to operate with the keyboard. As an illustration
of the problem, have a look at this dialog, which is used for setting the
Paper Size in the word-processor:

With the mouse, you can simply click on each option to change its value.
With the keyboard, it is not immediately obvious how you change the
options, or how you choose which one you want to change.

Tab and Space: the "Focus"

The key o operating dialog with the keyboard is to use the [Tab] and
[Space] keys. When a dialog is displayed, one of its ohjects always has the
“locus” - the focus is indicated by an outline around the object, and it
means that you can activale the objoct by pressing [Space]. 1M you lock
carefully at the illustration, you should see a dotted outline around the OK

button

This outline indicates that the OK button has the "focus®, so pressing
[Space] at this point would perform the same function as clicking with the
mouse on the OK bution.

Pressing [ Tab] repeatedly moves the focus around all the dialog objects in
turn, Y ou can see how this works by displaying any dialog on the screen,
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and pressing the [ Tab] key - you should see the "focus® highlight moving
arcund all the different dinlog objects in turn.

In the Paper Size dialog, for example, pressing [Tab] once moves the focus
to the Cancel button. So vou can cancel the dialog by pressing [Tab] once,
then [Space]. Pressing [Tab] twice moves the focus to the Help button.
Pressing it a third time moves the focus to the "A4" option box, which now

You can continue pressing | Tab] to move the focus highlight onto any
object in adinlog, and vsing [Space] to activate the focused object.
Shift+Tab E

You can also use [Shifi]+[Tab] to move the focus back through the objecis.
If you press [Tab] too many times and step past the object vou want, you
can press [Shift]+{Tab] to step back to il.

Using Other Keys

Onee you bave moved the focus onto a particular object, you may be able
1o use other keys to change the object's settings: in the Paper Size example,
once you have moved the focus onto the Paper Height or Paper Widih
spinners, you can use the T4 keys to increase or decrease the settings.
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Appendix E:
The PcW16 Character Set

MO O30 3 WD O el O LR RO RO —

This grid shows all the characters and accents you can type and print using
the PeW16's word-processor, and the "codes” used to represent them in the
PeW 16 operating system. In the table below, the codes are shown in a
standard character grid format, in hex notation: in the range 820-#7F, the
set is ASCl-compatible.

Note that the codes are not contiguous: there are no characters in the mnge
#B0-#EF.

2 3

.
o
o
i
o
i
=

F

|azcents)
Grave
Acule
Limlaun
Tilde

Hacek

Ring
Circumflex
Over-Dot
Macron
Breve
Double-Acute
Apostrophe
Uinder-Dot
Comma
Cedilla

= g »  Ogonek

Mouost of the characters from #7F upwards are not printed on the keys - sce
the next section for a guide to typing the extra characters.

1t 4 e B :--E
WS wd B WA B Ll e D
CZEZCR-—SOmone=E
d— e MNEREFLco—SwROT
08 8 =K .n R TR
| == — = M f & 8 ~ A =0T
LT+ s po0=0@ - 13
hxOhenTT 058 AR ME
B EFREBC N o -+ |

=Y I A=

!
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Typing the Extra Chara

Cirl+*
*  Sh+Cuj+
Cirl+2
Sh+Cirl+1
ShCrl+K
ShCrri+L
ShHCrri+Y
Sh+Cirl+;

Sh+Cirl45
Tasks+T
Tasks++
Tasksti—
Tasks+-»

Lt aepo=00

Typing the Accents
To type an aceented character, type the sccent first, then the character.

Sh+Crrl+0
Sh+Cirl+D
Sh+Crrl+H

clers

AEE A=

&

FESmenIe 6 F

Sh+Curl+B
Sh+Crr+9
Cirl+9
Sh4+Curl+8
Cirl+8
Sh+Crrl+l
Sh+Curl+ T
Sh+Crri+C
Sh+Cirl+Z
Sh+Ctrl+X
Sh+Crri+P
Ctrl+0

E
Sh+Crrl+0
* {Keypad)
Sh+Crr Delete

= [heypad)

+ (Keypad)
Ctrl+.
Sh+Cirl+#
ShiCrrl+Red
Sh+Cirl+Gireen
Sh+Curl+|
Sh+Crrl+]
Sh+Ctri+f
Sh+Cirl+R
Sh+Curl+E
Sh+Cirl+0)
Sh+Crri+W
Sh+Cirl+1
Sh+Cirl+,
Sh+Crl+.
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Appendix F:
Technical Notes on Discs and Filing

Although the PeW 16 disc appears 1o use a unique formal (a fixed number
of folders, and support for 32-character filenames), this is really just an
extra layer of disc management which sits on top of a standard DOS disc
filing system. This appendix gives a brief description of how this layer
works.

Note that the Import and Export commands in the Word-Processor and the
Spreadsheet can read and write files to and from the root directory of a
DS dise, but DOS files and discs cannot be manipulated directly using
the PcW 16's File Manager.

Notes on Exporting, and DOS File Names

The word-processor, spreadsheet and address book programs all have
Export commands, which allow you to export & file onto a DOS disc for
use with a different computer. When typing DOS filenames, you should be
aware that the range of characters you can use is very restricted, and the
length of the name must conform to the DOS standard,

Giraye Tasks+* DOS file names are compased of an eight-letter name, followed by a full-
Acute Tasks+1 stop, then a three-letter "suffix”, The Suffix is often used to indicate what
Ui lanst Tasks+2 type of data the file contains - for example, files containing Comma-
Tilde ?shﬂ Separated Value data (as used by the spreadsheet and the address book)
;i?ﬁ i wﬂkﬂs normally have the suffix ".CSV". When naming DOS files, you should
Cinn:sum!'lex Tacks+6 ensure that include an appropriate suffix. Usually, if vou type only the
Over-Dat Tasks+7 main section of the name without adding a suffix, the PeW16 program will
Maeron Tasks+§ automatically add an appropriate suffix for you,
Bt Tasks+9 You cannot use any spaces, puncluation or secented characters in [0S file
Double-Acuts Tasks+0 names. when Exporting to DOS files, ensure that the name you type is
Apostrophe Tasks+- compatible with all DOS systems by using only the letters A-Z and the
Under-Dot Tasks+= digits 0-9 in the file name,
Comma Tasks+#
Cedilla TasksH]
Ogonek Tasks+]
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PW16 Disc Directory Structure The Ayeta Foldes hy
When the PeW 16 formats a floppy disc, it uses the standard DOS format, e System Folder on a floppy disc is normally only used if the disc is a
but creates an additional directory structure as follows: backup of the Cabinet. The Cabinet System Folder is used for storing all
the PeW 16 system files, including the Diary and Address Book data files,

““ﬂl“m Fonts, Help files, word-processor Templates, and so on. You should never
ol delete files from the Cabinet System folder unless yvou know exactly

| what you are doing,
—SYSTEM IF you do need 10 make some space available in the Cabinet, however, you
{—FOLDERD can delete the Help files - these are not essential to the PeW16's operation,
I e File Names and Suffices
\—FOLDER1E The PeW 16 uses the file suffix of the real DOS pame to determine the file

The \PCW directory also contains a special file called CATALOG.TXT: type. The types recognised by the PeW16 include:

this is the file which cross-references the PeW 16's 32-character filenames SYS o System file {cannot be debeted if located in System folder)

to real DOS filenames, and contains additional information used by the WPD a WP document

PoW 16 filing system. When a PeW 16 program creates a file in a particu- WFT o WP Template

It folder, the file is stored in the corresponding directory under a DOS WIT o WP Template Template

name (eg PCWO0D 1. WPD), and this name is stored in the CATALOG.TXT 53 aSpreadsheet

file along with the 32-character file name which was given by the user HLP aHelp file

when the file was created. WPF  a word-processor bitmap Font file

I you want to use a XS machine to access a file on a PeW 16 dise, you FNF  afont family file

must look in the CATALOG, TXT file to find the real name of the file, then i S ! .

look in the Folder structure for the file itself, Note that the Folder names s e s st o ¥y n (e ki eectly

can be changed by the user using the File Manager - the FOLDERO,
FOLDERD? efe names are merely the defaults.

IMPORTANT NOTE
Although you may want to look ait the contents of CATALOG.TXT 1o
eross-reference DOS and PeW16 filenames, you should NEVER edit,
alter, copy or in any way rewrite CATALOG.TXT. If you do, the
PeW 16 will probably be unable to use the disc in future, Likewise, if you
want to copy & PeW 16 dise using a DOS system, you must use a Sector-
based copying system (eg DOS"s DISKCOPY program, rather than just
copying the file and directory structure. [fyou do not use o sector copier,
the resulting disc will probably not wark with the PeW 16.
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Appendix G: Troubleshooting

Problem

bt displayvs n message ssking you 1o
sert the Rescue Disc

The PeWi6 docs nod danm up oomally,

The serecn dogs nal come on even
though the preen: light @ on

The mouse pointet docs Bl e

The memse polnter moves perkily.

The keyboard docs mal wivk

Check that the keybosnd is connecsed o
the keyboard port os the back of the unil

The keybosrd secrma 1o respand
incorreetly

The premter docs mat prnt, or priod
imcorrectly

The clock or dale o inconrect

Cannot find & file on & DOS disc
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Backing Up

Cell

Clicking on...

Column and Row

Discs

Glossary

Making a Backup copy of your work means making a
spare copy and keeping it safe. When using o computer,
it is easy o lose your work, either by deleting it acciden-
tally, or through a power interruption or some malfunc-
tion of the computer. Keeping a backup copy of your
important documents and files means that you can
retrieve your work if something goes wrong with the
original files.

The Cabinet is the PcW | 6's own internal storage system
It performs two functions: firstly, it stores your word-
processor documents in "Files™, which you can group
intodifferent "Folders" to keep them organised.
Secondly, the Cabinet holds the programs, typefaces and
other information which your PFeW 16 needs to function.
If the Cabinet malfunctions and becomes cormipted, you
may need 1o use vour "Rescue Disc" to make your

PeW 16 work again,

The elements in n Spreadsheet are called Cells - they are
arranged in columns and rows,

Placing the mouse pointer over something on the screen,
then pressing and releasing the mouse lefi button (or
right button if the buttons have been reversed), is called
Clicking an the object.

Spreadsheet cells are arranged in vertical Columns and
horizontal Rows. See buroduction to the Spreadsheet,
page 97,

Your PeW 165 disc drive uses standard 3% floppy discs,
which you can use for storing files, and for transferring
your work between different computers, You should
always keep spare copies of your work on disc: see
Backing Up,
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Glossary Index
Double-Clicking The same as Clicking (see above), but the mouse button [“ dex
is pressed and released twice in quick succession.
! o G o 3" PCW dises 67 Cells
Files All computer information is stored in Files, but this isa Selecting 100
technical matter which is not very important if you just A Cels (Spreadshest) 97
want {0 use the word-processor. All you need to remem- Abandon Document 77 Numeric Formats 9§
ber is that your word-processor documents are really Abandon Spreadsheet 104 Text Formais 98
files, and you can move them around and make copics of Accents 156 Centred Texi 93
them using the File Manager program, Add New Appointment 128 Change Column Width 107
Add New Entry 120 Change Dise 142
Floppy Disc See Dise. Address Book 32, 117 Changing the Paragraph Format 92
Folder PeW 16 discs contuin sixteen different Folders in which M:""“':';Ii'll 76 mﬂﬁ“&‘;:"rr;sm'"ﬂ 9
you can store your documents and other files. You can by S
give these folders names to help you organise your work. :Ih"' DEP‘:“" l.'n;;:r;aﬂ 128 Check swh#ugl 73
Greyved Ot Sometimes you will see that a command appears dotted Alphabetic List of . 117 OKI Printer 55
and faint in a meny. This happens when the program is Apply Format (Spreadsheet) 107 Cleaning the Computer 147
in a particular situation which makes it impossible to use Appointments (Diary) 37, 128 Clicking 14
the command. Mormally, commands which cannot be mgm Without Times 128 % t::lu'ld‘lh © ) 107
are greyed-out to indicate that they are unavailahle. 128 Columns ($ sheet) 97
Restore When you use the Backup command to make a complete Time 128 Commands 46
copy of the contents of your Cabinet, you can then use Archive 140 (.‘mlpuilhimy
the Restore command o copy the backup files back inta AsClL Printers |50
the Cabinet again - see Buckup, Exporting 68 Copy Selection to Scratchpad
: Importing 66 Spreadsheet 103
How See Colummn Auto-Recaleulate 110 Word-Processor 78
Toggle A Topgle i3 a setting which can be either on or ofT, and B Coprying Flle(x) 113

which changes from one to the other when vou select it
You can normally switch a toggle by elicking on it with
the monse. For example, an aption box in a dialog is a
toggle: click on it once to switch it on, then again to
switch it off. Some menu commands are Toggles, and
ean be reselected o switch them on and ofT.
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Backing Up the Cabinet to Disc 141
Backing Up Your Work 44

Backup 44

Bold 62, 89

Lo

Cabinet 41, 131
In the Word-Processor 64
Calealator 40
Calendar 13
Canon Bubblejet Printers 151

Counting Words 73
CPM
Importing Documents 67
CP/M Dises 102
CSY Files
Address Book 118
Spreadsheet 102
Currency Symbol (Spreadsheet) 112
Carrent Cell 98
Cut Schection to Scratchpad
Spreadsheer 105
Word-Processor 78
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Index

D

Date, Setting 13
Date Format

Spreadshest 113
Word-Frocessor 96

Day + { Day - See Using the Diary
Decimal Character (Spreadsheet) 112

Default File Storage 137
Default Numeric Format 112
Default Text Format 112
Defining Numeric Formats 111
Delete Appointment 129
Delete Cell Contents 106
Delete Entry (Address Book) 121
Delete Selection

Word-Processor 78
Dileting File(s) 136
Deleting Fonts 56
Deskjet Printer 152
Desktop

Introduction 17
Desktop Sctup 54
Calendar 123
Diary [ Alarm 36
DIF Files 102
Disc 19, 41, 157

Backup 44

Format 158
Discs

Folders 139

Ini the Word-Processor 64
Display Grid-Lines 110
DOS Dises 102
DOS flenames 157
Dot-Matrix Printers 152
Diraft option (Printing) 75
Drop-Lists

with the Mouse 49
Drum Counter

OKI Printer 55

Duplicating Dises 142
E

Edit Appointment 129

Edit Cell Contents 105

Editing a Stored Document 65
Editing a Stored Spreadsheet 102
Emulation

Printer 150
Epson Stylus Printer 152
Export

Address Book 119

Exporting a Spreadsheet 103

Expressions (Spreadsheet Formulee) 114

External Programs 53
Extra Characters 156

F

File Manager 131
File Size 132
File Type Indicator 132
Filenames 43
m DOS 157
Fill Across 107
Fill Down 107
Find Entry {Address Book) 121
Find Text
Spreadsheet 109
Word-Processor 80
First-Line Indent 93
Floppy Dise 133, Ser alvo Disc
Floppy DMscs 19
Focus in Dialops 153
Folder Names 42
Cabinet 140
Disc 142
Folders 41
In the Word-Processar 64

Index
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Fonts
Installing and Deleting 56
Size and Style 90
Footers 70
Formatting Discs 142
Formula (Spreadsheet) 99

Funetions in Spreadsheet formulae

114
G

Go to Cell 109
Go to Date... 126
Groups (CF/M) 103

H

Headers and Footers 70
Editing 71
Printing Options 70
Help 19
Hot-Keys 47

Import {Address Book) 117

Importing o Spreadsheet 102

Importing Documents 66

Inches. See Measuring Units

Indenting a Paragraph 89

Indents 60, 93

Inkjel Printers 151

Insert [ Overwrite 85

Insert Calculation
Spreadsheet 108
Ward-Processar 6

Insert Character 87

Insert Column (Spreadsheet) 108

Insert Date
Spreadaheet 108
Word-Processor 86

Insert Document 85

Insert Mail-Merge Code 58

Insert Name/Address 86
Insert Row (Spreadsheet) 108
Insert Stored Phrase 85
Insert Time
Spreadsheer 108
‘Word-Processor BS
Installing Fonts 56
Italic 62, 89

J

Justified Text 93
K
Keyvboard

Connecting 11

L

Laser Printers 151
Left-Aligned Text 93
Lefi-Handed 55
Line Spacing 93
List Order (File Manager) 138
Lists

in Dialogs

with the Mouse 48

Locoscript Documents 67

M

Mail-Merge
Codes B8
Printing 76
Making a New Template 72
Manual 18
Margins 69
Match Case Option 81

Mathematical Functions & Formulae 114

Mensuring Units 69, 96
Menus and Commanids 46

with the Keyboard 47
Millimetres. See Measuring Units
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Month + / Month -, See Using the
Diary
Mouse
Cleaning 147
Connecting 11
Imroduction |4
Options 54
Moving File{s) 135
Muoving the Cursor

Spreadshest 99
Word-Processor 57

N

Numbers, Aligning in Columns 90
MNumeric Format 111

o]

Operating System 56
Operators in Spreadsheet formulae
114
Options
Diary. 129
Options Boxes 49
Overwrite Mode 85

P

Page Numbering 71
Paper Size 68
Paper Thickness
OKI1 Printer 55
Paragraph Format 92
Paragraph Style
Creating 95
Paragraph Styles 61
Editing 94
Using 93
Paste from Seratchpad
Spreadsheet 105
Word-Processor 78
PCW, Older Models 67

Percent Button (Caleulator) 40
Phrascs
Inserting 85
Storing 79
Point Size 90
Point Sizes 63
Positioning yvour PeWi6 9
Preferences
Word-Processor 96
Print Density
OKI Printer 55
Print Preview
Spreadsheet 104
Word-Processor 75
Printer
Connecting 12
Selecting 16
Printers 150
Diot-Matrix 152
Inkjet 151
Laser 151
Printing & Document 75
Printing a Spreadsheet 104

Q
Quality option (Printing) 75
R

Re-Paginating a Document 74
Recalculate Now 103
Remove Column 106
Remove Row 106
Renaming Files 136
Repent Options (DMary) 128
Replace Text 81
Resolution

Printing 130
Restoring the Cabinet from Disc 141
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